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1. Safety
Please make the following safety information available to any person who comes in contact with Cirris equipment. 

Cirris will not be held liable for injuries suffered if the tester is not properly maintained or if safety guidelines are not 
followed.

1.1  Symbols

The Electricity Hazard Warning symbol, found on the front of the 4250 tester, indicates that high 
voltage is produced by the tester and, therefore, there is a risk of electric shock during use. The 
symbol is also used in this manual to highlight unsafe conditions presenting a risk of electric shock.

The Disconnect Mains Plug from Electrical Outlet Mandatory Action symbol used in this manual 
indicates that for safety, the tester must be disconnected from power before proceeding the de-
scribed process. 

The No Children Allowed Prohibition Symbol indicates that children are not permitted to operate 
the tester.

The No Access for People with Active Implanted Cardiac Devices symbol indicates that no per-
son using an electronically-controlled medical device is permitted to perform high voltage testing.

1.2  High Voltage Warning
This manual provides instructions for two separate, but very similar testers. The chief difference between the two is 
that the 4200 performs only low voltage testing while the 4250 is also capable of performing high voltage Dielectric 
Withstand (DW) and Insulation Resistance (IR) testing.
By design and purpose, the output of high voltage test equipment presents a risk of electric shock. The extent of 
the risk is a function of the voltage, current and high voltage energy or charge. In order to mitigate the risk, the high 
voltage energy limit of the 4250 is 35 mJ and the high voltage charge limit is 45μC. These limits prevent circuits 
energized during high voltage testing from meeting the definition of hazardous or dangerous live points found in 
international standards. 

● IEC 61010-1:2010, which specifies general safety requirements for electrical test and measurement equipment,
states in section 6.3.1 that in a dry environment 60 volts DC or 30 Volts RMS (or greater) are deemed to be “HAZ-
ARDOUS LIVE” if the current exceeds 0.5 mA RMS or 5 mA DC and the level of capacitive charge or energy
exceeds 45μC at the same time. The maximum charge limit of 45μC means the high voltage output of the 4250 is
not considered HAZARDOUS LIVE.

● European standard EN 50191 defines requirements for the erection and operation of electrical test equipment and
focuses on measures to ensure operator safety. It states that compliance with the standard is not necessary if con-
tact with live parts presents no danger, which it goes on to say is the case if the discharge energy does not exceed
350 mJ. The requirements of the standard are not mandatory for the 4250 due to the unit’s 35 mJ high voltage
energy limit.
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1.3  Medical Warning

Individuals using a cardiac pacemaker, an insulin pump, or any other electronically-controlled medical 
device should NOT perform high voltage testing.

1.4  High Voltage Safety
The restricted high voltage energy and charge limits of the 4250 do not mean that performing hipot testing with the 
tester is entirely without risk as operators can still receive a startling or even painful shock. Therefore, it’s necessary 
and prudent to protect operators. Consider the following while recognizing it is not an exhaustive list.

 1.4.1  Training
Operators should only use the test equipment after they have been properly trained.

● Operators should understand the hazards of electricity and that electric current will take any path to ground
including through a person.

● Operators should know how to use the test equipment and how to recognize when high voltage testing is being
performed.

● Operators should understand not to touch the product being tested or any test fixture hardware during high volt-
age testing

● Operators should understand test processes and their importance

● Operators should understand that untrained workers should not be allowed to use the test equipment.

 1.4.2  Test Stations
Training alone is not as effective as eliminating access to hazards. 

● Protection from energized points can be accomplished by insulation, covers, enclosures, obstacles or safe dis-
tance. A remote start button and/or safety interlock can be used as part of a protection strategy. The 4250 sup-
ports the use of either or both.

● Use a non-conductive surface for testing. Do not use an Electrostatic Discharge (ESD) station for testing. Conduc-
tive materials can create a connection path between exposed connections or connector shells and the operator.

● Do no use the tester is a wet environment or in the presence of flammables gases or explosive fumes.

● Verify that the power outlet provides a properly wired, low impedance earth ground. The connection to earth
ground is integral to the power cord supplied with the tester.

● Isolate high voltage testing from untrained employees and post high voltage warning signs at the test station
boundary.

● See Ideas for Improving Hipot Safety on the Cirris web site for more information.

https://www.cirris.com/learning-center/general-testing/high-voltage/106-ideas-for-improving-hipot-safety?highlight=WyJoaXBvdCIsIidoaXBvdCIsInNhZmV0eSIsImhpcG90IHNhZmV0eSJd
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1.5  Intended Use

4200 Series testers are designed for electrical testing and are intended to be used indoors, in a dry environment, at a 
temperature of 50-104 degrees Fahrenheit (10-40 degrees Celsius). Best performance can be achieved at a relative 
humidity of less than 70%. Insulation Resistance measurements will degrade at over 70% relative humidity. 

Never apply live voltages to the test points or probe input of your Cirris tester. Power supplies and 
other accessories not approved by Cirris may cause damage or present a hazard.

Warning: If the equipment is used in a manner not specified by the manufacturer, built-in 
protections provided by the equipment may be impaired.

1.6  No User-Serviceable Parts

The tester includes no user-serviceable parts. Attempting repairs or altering the tester in any way will 
void the warranty and may lead to an unsafe condition. Contact Cirris Technical Support for assistance 
with tester issues. See Section 27 for additional information.

Section 2.5 of this manual provides instructions for installing Expansion Scanners, which requires 
access to the inside of the tester chassis. As described in Step 1 of that process, the power must be 
disconnected any time the inside of the tester chassis is accessed.

1.7  Moving the Tester

Before lifting or carrying the tester, Cirris recommends removing all wires and cables from the tester. Be sure the 
power cord is unplugged. Handles are provided on the front of the tester to make lifting and carrying the tester 
more convenient.

1.8  Help/Support

For assistance:

● Visit the Learning Center of the Cirris Web Site (www.cirris.com/learning-center) to view articles on Cirris prod-
ucts and other testing subjects.

● Contact our technical support team by email at techsupport@cirris.com or by telephone at +1 801 973 4600,
ext. 666 (or ask for Tech Support). Normal business hours are 8:00 AM - 5:00 PM Mountain Time in the United
States.

● Visit the Contact page of the Cirris Web Site to find sales and service contact information.

http://www.cirris.com/learning-center
https://www.cirris.com/contact-us
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2. Hardware Set Up

2.1  You should have received
● Cirris 4200 Low Voltage or 4250 High Voltage Cable Tester

● Power cord

● PC (USB A to USB B) cable

● Probe

● Antenna

● USB flash drive containing software/documentation

● Optional: Adapters, expansion boxes, tilt stands, and other accessories.

	●

2.2  Front of Tester
a. 7" full-color graphical display with capacitive touch screen (800 x 480 pixel resolution).

b. Cirris adapter system creates an easy fixturing setup system.

c. High voltage warning symbol

d. Handles for portability

e. Adapter slidelocks

f. 1/4 - turn fastener (4 places on base tester & on each expansion scanner)

A

D

B

C

E

EF
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2.3  Top of Tester
a. Digital I/O: Test programs can be configured to accept digital inputs to output digital signals to initiate events

or indicate specified conditions.

b. Serial ports: Can be used to connect a qualified Zebra label printer, for connecting a qualified report printer
using a smart serial to USB cable available from Cirris or for connecting a PC for communication in some
automation applications.

Note: The serial ports are interchangeable. Both can be used for printing, PC control, or LUA scripting. 
However, the ports cannot be used for the same purpose at the same time. For example, only one printer can 
be connected to the tester at a time. 

c. Probe: Attach the probe to identify test points, for troubleshooting and for help diagnosing failures.

d. PC (USB Type B port): A PC can be connected to the tester using a standard USB Type A to Type B cable.
With the tester connected to power but turned off, the tester’s memory will appear as a flash drive to the PC.

e. USB Type A port: Use a flash drive to back up or transfer test programs. Connect a bar code scanner to en-
ter Lot IDs. A bar code scanner can also be used to enter other data, like serial numbers, using the optional
scripting capability.

f. Ethernet: Use an Ethernet cable to connect your tester for network printing and back up using the Cirris Hub
software.

g. Antenna: Connect to the Cirris Hub on a network using WiFi.

h. Power Cord: Attach the power cord.

i. Power button: Turns tester on and off.

2.4  Setting up the Tester

Set Up Test Hardware

1. Connect the power cord to your tester.

Printer/Serial  1

Printer/Serial  2

A B C D E F G H I
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2. Plug the power cord into a grounded outlet (surge protector recommended).

3. Connect the probe.

4. Press the power button to turn on the tester.

5. The tester will perform a system diagnostic (see page 53).

6. After startup, the tester may require that you set the date and time for your area.

7. The Main Menu screen will open.

Set Date and Time
Setting the date and time ensures the correct information will show on test reports.

From the Main Menu, press System Settings. 

The date and time are displayed on the buttons so you will be able to see if they need correcting. Press the button to 
change the information.

Press the button for the field you wish to change. For example, if you wish to change the month, press the month 
button and select the correct number.

You can also select how you want the date and time displayed by pressing the drop down inside the date or time 
menu and selecting an option from the list.

Once finished, press the OK button to save the changes.

Press Done to return to the Main Menu.

Set Mains Frequency
Also known as Power Line Frequency, you will want to set this value to 50 or 60 Hz depending on your country’s AC 
line frequency. The correct selection will improve test measurement accuracy.

From the Main Menu, press System Settings.

Press the Mains Frequency button to switch it to either 50 or 60 Hz. 

Press Done to return to the Main Menu.

Note: For more setup options, such as changing the language or volume, see System Settings on page 53.

2.5  Expansion Scanners Installation
Each expansion scanner provides an additional 128 test points. Up to seven expansion scanners can be added to a 
base unit for a total of 1024 test points.

1.	 Turn the tester off and disconnect the unit from power.
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2. On the Base Tester, use a screwdriver or a quarter to turn the 1/4-turn fasteners to a horizontal position and
remove the cover plate from the chassis by lifting it vertically.

3. Remove the scanner assembly by lifting it vertically out of the chassis and place it face down next to the tester.
Do not disconnect the ribbon cable connecting the scanner to the tester base.

4. Using a flat object, like the side of a flat-blade screwdriver, from the INSIDE of the chassis, press out the four
rivets on the right side of the Base Tester detaching the plastic cover piece.

1/4 Turn Fasteners
Turn Horizontal

1/4 Turn Fasteners
Turn Horizontal

Cover Plate

Scanner Assembly

Daisy-Chain 
Connector

Ribbon Cable

4250 Shown - 4200 Similar

Right Side View of Base Tester

To gain access to the daisy-chain connector, 
remove black, plastic cover by pushing
out four rivets from inside the chassis 
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5. Replace the scanner assembly with the daisy-chain connector temporarily accessible outside the Base Tester
chassis. Do not replace the cover plate yet.

6. Connect the Expansion Scanner, male, daisy-chain connector to the female, daisy-chain connector on the Base
Tester ribbon cable. The daisy-chain connectors on 4200 testers have 34-positions and the daisy-chain
connectors on 4250 testers have 40 positions.

7. While pushing the Expansion Scanner and the Base Tester together, insert the mated daisy-chain connectors
into the Base Tester chassis. Posts on the Expansion Scanner will fit into corresponding holes on the Base Tester
to guide the units together. Secure the Expansion Scanner to the Base Tester using the two side latches on the
Expansion Scanner and reinstall the cover plate.

8. Space is available on the cover plate of each Expansion Scanner to write the adapter positions. You may also
consider using removable stickers for this purpose. For example, you could continue the number system and
label each adapter position as J5, J6, J7, etc.

9. If attaching more than one expansion box, repeat the process as necessary.

4250 Shown - 4200 Similar
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 2.5.1  Expanding 4250 Testers to 1024 Test Points

If a 4250 tester will be equipped with its maximum of 7 expansion scanners (1024 test points total), a special internal 
cable, part number CBL-1024, is required. The cable is ONLY needed when expanding the tester beyond 896 points.

1. With power disconnected and the internal scanner removed from the chassis (steps 1-3 above), find the
connection point for the ribbon cable that connects the internal, base unit scanner to the Backplane board, which
is mounted vertically inside the chassis on the back panel. The cable is marked 4250 LB TO SCANNER and it’s
attached to a connector marked PRIMARY SCANNER SET near the right side of the Backplane board.

2. On the Backplane board, immediately to the right of the PRIMARY SCANNER SET connector is an unused,
40-position, dual-row connector. Connect the end of the CBL-1024 cable that has a single, dual-row, 40-position
connector to the previously unused connector on the backplane board.

3. Connect the first three Expansion Scanners to the Base Tester using the primary daisy-chain as described in
steps 1 - 9 above. At the same time, route the CBL-1024 cable through the first three Expansion Scanners using
the same chassis cutouts used for the primary daisy-chain.

4. Connect the CBL-1024 cable to the fourth Expansion Scanner (scanner #5) using the dual-row, 34-position
connector at the end of the cable assembly.

40-pos, Dual-Row, Keyed,
Female Connector (2 PLCS)

34-pos, Dual-Row, Keyed, Female Connector
Connects to Scanner Motherboard (4250 LB
to Scanner Cable to Scanner #1, CBL-1024
to Scanner #5)

4250 LB to Scanner and CBL-1024 Cables (same design - di�erent lengths)

Connects to 80-22014
Scanner Add-On Cable
(Daisy-Chain Connector)

Connects to 4250 Backplane
Board in Tester Base

80-22014 Scanner Add-On Cable

34-pos, Dual-Row, Keyed, Female Connector
Connects to Scanner Motherboard

40-pos, Dual-Row, Keyed, Male Connector
Connects to Daisy-Chain Connector on 
4250 LB to Scanner Cable, CBL-1024 Cable
or on another 80-22014 Scanner Add-On Cable

40-pos, Dual-Row, Keyed, Female Connector
Connects to another  80-22014 Scanner Add-On 
Cable as needed (Daisy-Chain Connector)
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5. Use scanner add-on cables, part number 80-22014, to connect scanners 6, 7 and 8 to scanner 5 in the standard
daisy-chain configuration. The single dual-row, 40-position connector on one end of the 80-22014 Scanner Add-
On Cable connects to the 40-position, in-line connector near the end of the CBL-1024 cable at Scanner 5.

Base Tester
128 Points

Special Cable, CBL-1024
(only req’d in testers with 1024 points)

Scanner Add-On Cable, 
80-22014

Scanner #1
(Internal/Primary)

#2 #3 #4 #5 #6 #7 #8
Standard 4250 LB to 

Scanner Cable
Scanner Add-On Cables, 80-22014
In testers with up to 896 points (6 Expansion Scanners/7 Scanners total) 
this primary daisy-chain continues through the last scanner Connector Marked 

“Primary Scanner Set”

Backplane Board 
Mounted Vertically 
Inside Chassis on 

Back Panel
Scanner Add-On Cable, 

80-22014 (6 Places)

4250 Cable layout with detail removed for clarity
(Cables routed internally through enclosures) 

Cross-section View (Backplane pictured horizontally for clarity)

Special Cable, CBL-1024
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3. Installing Adapters/Fixturing

3.1  Installing Adapters
The 4200 Series uses interchangeable adapters that connect the DUT to the tester. Cirris sells a variety of adapters 
that mate to standard connectors. We can also create custom adapters for less common connectors. Visit cirris.com 
to learn more.

Push the slidelocks to the outward positions.

Set an adapter in one or more of the J1-J4 slots. With a firm but gentle force, push the adapter forward (toward the 
tester’s screen). You may have to use more pressure than expected to move the adapter completely into position. Be 
careful not to bend any pins as you slide the adapter into place.

Note: Larger sized adapters can take one, two, or four positions at once. For example, a connector could use 
both the J-1 and J-2 positions. An adapter in this position will register in the software as a J1 adapter.

Once the adapter is firmly connected, move the slidelocks to the inward position to hold the adapter in place.

3.2  Fixturing
Sometimes cables are built with connectors that cannot attach directly to the tester. For this reason, fixturing must be 
built to provide a way to connect the device-under-test (DUT) to the adapters in the tester.

Fixturing refers to the interface between the DUT and the tester. Fixturing can be a significant portion of the 
investment in a test system. Good fixturing is an essential part of ensuring the accuracy of test results and maximizes 
the test station’s throughput. This means fixturing needs to be at least as good, if not better than the quality of your 
DUT. Remember, you want to test the DUT, not the fixturing.

Cirris makes generic mating cables with one end that connects to the tester while the other end has unterminated 
wires. These cables save time by completing part of the work of creating fixturing cables. To learn more, visit cirris.
com or contact your account manager.

3.3  Mating Cycles
The quality of parts used will affect the life of your fixturing. Each time a connector mates with another connector, 
it experiences wear. Connectors are rated for a specified number of mating cycles before the contact resistance 
increases. 

Lower quality connectors (typically with tin plating) may be rated for as few as 10 to 50 cycles, while more expensive 
connectors (typically with gold plating) are often rated for over 500 cycles. In practice, these connectors can often 
experience far more mating cycles and still perform adequately for test measurements. 

If you are focused on having very precise resistance measurements in your testing, you will want to carefully consider 
the materials you use for fixturing, and maintain a maintenance schedule to ensure connectors are replaced before 
they cause errors in your resistance measurements. 
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4. Cirris Hub Software
Before continuing with the tester setup, it’s recommended that you consider installing the Cirris Hub software on 
a networked PC in order to take advantage of the built-in networking capability of the 4200 Series testers. While a 
connection to the Hub is not necessary, and it can always be added later, the version of the Hub included with the 
tester provides a variety of capabilities, including:

● Storing test programs on a network drive for easy backup of the files.

● Sharing test programs stored on a network drive or cloud drive among multiple testers.

● Sharing test programs with remote locations.

● Printing reports to network printers.

● Printing reports as .pdf files.

● Editing test programs using the Hub editor.

● Organizing testers with custom names and tracking calibration status and firmware version.

● Monitoring the current status of testers (Online / Offline / Testing).

A free version of the software is found on the USB flash drive that came with your tester. For more information and 
installation instructions, see the Cirris Hub Manual.
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5. Testing Basics

5.1  Types of Tests

The 4200 Series allows you to customize which tests you want to run on a cable. While the tester will always per-
form a low voltage test, you can choose to include a high voltage or intermittents test. 

Low Voltage Test
Low voltage testing detects errors such as shorts and opens by applying current to a wire and measuring the voltage. 
The wire will have a current affected by several factors including resistance and components. If the wire is connected 
correctly, the test will read low resistance. That means current is flowing through the wire as expected and reaching 
the required connections. If the tester reads high resistance it means something is impeding the current from 
reaching its destination. This could be caused by a number of errors:

● Open error: The expected connection is not present.

● Miswire error: The wire is connected to the incorrect point.

● High Resistance: The expected connection is measuring above the pass/fail threshold but less than the low
voltage insulation resistance (isolation) threshold.

● Incorrect test setting: A test setting is set to an incorrect value or has another mistake.

High Voltage Test
A high voltage or hipot test checks for good isolation. Having good isolation helps to guarantee the safety and quality 
of electrical circuits. If the points are isolated, no current will flow between points where there should be no current. 
A hipot test takes two conductors that should be isolated and applies a very high voltage between the conductors. If 
too much current flows the points are not well isolated and they fail the test. 

Hipot tests are helpful in finding:

● Nicked or crushed insulation.

● Stray wire strands or braided shielding.

● Conductive or corrosive contaminants around the conductors.

● Terminal spacing problems.

● Tolerance errors in Insulation Displacement Contact (IDC) cables.

All of these conditions might cause a device to fail.

There are three common high voltage tests.

● Dielectric Withstand Test: Determines that a cable can withstand voltage for a certain amount of time.

● Insulation Resistance Test: Determines that cable’s insulation is sufficient.

● Dielectric Breakdown Test: Determines how much voltage the cable can tolerate before it fails. Once the
cable fails, it is usually damaged or destroyed. Cirris testers do NOT perform this type of high voltage testing in
any shape or form.
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Intermittents Test
Since intermittent problems are just that --intermittent--they are much more difficult to detect than stable defects. 
Intermittent errors are usually caused by a mechanical change including mechanical vibration, or physical flexing, 
which changes (temporarily) the electrical characteristics of the cable. The Intermittents Test allows the user to check 
for potential defects by moving the cable while the tester continuously checks continuity. If any failure is detected—
even momentarily, the test will fail.

5.2  Types of Errors
Each of the tests performed by a Cirris tester will look for certain errors in the cable. Understanding the errors will 
help you determine which tests you want to run as well as how to avoid creating these errors in your cable.

Low Voltage Errors
Open Error: The intended electrical path contains a gap across which electric current cannot pass at the low voltage.

Short Error: An unintended connection between two or more points. This failure indicates insufficient insulation 
between unintended connections.

Miswire Error: An unintended connection which is the result of unexpected contact. This error is often referred to as 
an open and a short combined.

Component Errors

A new test program containing a component will measure the component value in the sample device and assign a 
default tolerance range. During a test, if the tester measures a value outside of the tolerance range, the component 
instruction will fail with an error message that indicates the measured value as well as the expected value.

High Voltage Errors

Overcurrent Error: This error occurs because the tester expects to measure a certain amount of current, but a larger 
amount of the current flows through the wire than the tester expects. The tester assumes the current is escaping and 
reports an overcurrent error.

Often this error is attributed to capacitance. With wires acting as conductors and insulation acting as a barrier, cables 
can build up high amounts of capacitance. The tester cannot tell the difference between insufficient insulation and 
capacitance. Both causes will result in an overcurrent failure. If you know the wire is highly capacitive you can set the 
test program to prepare for the error. 

Had Leakage: This error occurs because too much current leaks between unconnected points. It is natural for some 
current to leak through insulation or through contaminants such as flux residue. A Had Leakage error occurs because 
more current leaks from the wire than is acceptable.

Dielectric Failure: A Dielectric Failure means voltage has arced from one of the wires. This normally occurs between 
two exposed pieces of metal. The test will immediately abort and report a Dielectric Failure.

In rare instances, a dielectric failure will go away, such as when a dielectric failure caused by small solder slivers 
vaporizes during the high voltage test. 
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6. Main Menu

From the software’s Main Menu, you can access other areas of 
the software such as the test screen, edit test screen, and other 
menus.

	● Loaded Test: Displays the name of the currently loaded 
test program.

	● Signature: Displays the loaded test’s signature. Tests 
that are imported from other Cirris testers will show the 
same signature as displayed on those testers.

	● Edit: Change settings for a loaded test program.

	● View: View details of a loaded test program.

	● Test: Perform a test using the loaded test program.

	● Create New: Create a new test program.

	● Load: Load an existing test program to edit, view, or test.

	● Manage Files: Copy, move, or delete test programs and files.

	● System Settings: Perform a variety of tasks related to the setup and maintenance of the tester software includ-
ing changing volume, date, time, etc.

Cirris Tester

Edit

View

Create 
New

Manage Files

System Settings

Loaded Test: NewTest
Signature: XXXXXX-00000

Cirris 4250 Tester | SN: XXXXXXXX      Calibration Verified:  MM-DD-YY | Due:  MM-DD-YY  
Operator:

Load

Test
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7. Create a New Test Program
A test program must be created before testing a device. This is done by attaching a known-good sample to the 
tester, adjusting the test settings, and performing a Learn. The tester will create a list of test instructions based on 
the specified settings and the sample cable. Subsequent cables of the same type can then be tested using the 
instructions created during the learn.

1.	 Attach the fixturing (page 14) and sample cable to the 
tester. From the Main Menu > Create New.

2.	 The summaries on the right side of the screen describe the 
current test program settings. Press Edit Learn Settings 
to adjust the settings per the sample cable specifications 
(voltage, components, etc.).

Note: The default test settings for a new program are the 
same as those used on the last previous test created.

The Edit Learn Settings screen allows the user to edit the 
preferences and parameters for the new test program. With the 
exception of Components, these settings can be adjusted later 
by selecting Main Menu > Edit. The Components option only 
appears in the Edit Learn Settings where it’s used to instruct 
the tester which components to search for during the learn. 
After the test program has been created, the nominal values of 
components and their pass/fail parameters can only be edited on 
a PC.

	● Preferences – page 20

	● Low Voltage – page 22

	● High Voltage (4250 only) – page 24

	● Reports – page 27

	● Digital I/O – page 36

	● Components (new test only) – page 38 

	● Data Collection – page 39

When satisfied with the settings, press Save to return to the Create New Test screen.

Create New Test

Cancel

Edit Learn 
Settings

Learn
Attached Device

Preferences
 Low Voltage Start: Start Button
 High Voltage Start: Start Button
 Intermittents Test: For Duration
 Intermittents Test Duration: 2 S
 External Start Switch: OFF
 External Safety Switch: OFF
 Error Location: ON
Low Voltage
 Connection Resistance: 5 ohm
 LV Insulation Resistance: 100 k ohm
High Voltage (Hipot)
 AC Frequency: 60 Hz
 Cycles: 1 Cycle

Learn Settings

Edit Learn Settings

Save Cancel

Preferences

Low Voltage

High Voltage (Hipot)

Reports

Digital I/O

Components

Test Settings

Preferences
 Low Voltage Start: Start Button
 High Voltage Start: Start Button
 Auto Start Delay: 0.2 S
 Intermittents Test: For Duration
 Intermittents Test Duration: 2 S
 External Start Switch: OFF
 External Safety Switch: OFF
 Error Location: ON
Low Voltage
 Connection Resistance: 5 ohm

Data Collection
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8. Preferences

Low Voltage Start - specify which condition starts a test.

● Start Button: The test begins when Start Test is pressed or
an external switch is triggered with Digital I/O.

● Cable Attached: Test will begin automatically when a de-
vice is connected to the tester. This condition is generally
used for testing a high volume of simple cables because
it eliminates the time it takes to push buttons on the tester
screen to start each test. However, with this start condition
one of the following actions is required for a bad cable:

○ Press Finish Test: If the device contains an error, the low
voltage test will not complete until you press the Finish
Test button. The screen will update the failed test tally.

○ Remove cable: If the device contains an error and you remove the device before pressing the Finish Test
button, the test will be aborted with no record of the test.

High Voltage Start – 4250 only

● Start Button: The high voltage test will begin when the operator presses Start Test or when an external switch
is triggered with Digital I/O. This lets the operator choose when the high voltage test starts.

● Auto Start: The high voltage test will automatically start after a slight delay. The delay is used to allow opera-
tors sufficient time to ensure their hands are free of the tester and product before the high voltage test begins.

Intermittents Test

An intermittents test repeatedly performs the low voltage portion of the test to give the operator the opportunity to 
stress the product while the tester checks for intermittent faults. For example, the operator can flex the device in an 
effort to induce intermittent failures such as loose connections.

● OFF: No intermittents test is performed.

● Press to Stop: The intermittents test continues until the operator taps the End Test button.

● For Duration: The intermittents test continues for a predetermined amount of time. Test duration can last up to
120 seconds.

Note:  If Press to Stop is selected and the DUT is removed before the operator taps the End Test button, the test 
will fail. Likewise, if For Duration is selected and the DUT is removed before the specified time elapses, the test 
will fail.

Enter Lot ID 

A Lot ID is a unique identifier of the user’s choosing for a group or batch of cables. The Lot ID input is requested at 
the beginning of a test run and applies to all cables in that run. The operator can enter the Lot ID by using the pop-
up keyboard or by using a bar code scanner connected to the tester’s USB port to scan the input.

● ON: When this setting is enabled, the user must enter a Lot ID before the test window will open.

● OFF: No Lot ID is required before testing and won’t appear on reports.

Preferences

OK Cancel

Start Button
Auto Start Delay:

1 S

Enter Lot ID: Off

Error Location:
On

External Safety Switch:
OFF

External Start Switch:
OFF

High Voltage Start:

For Duration
Intermittents Test Duration:

2 S

Intermittents Test:

Cable Attached
Low Voltage Start:
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Error Location

If open or a short is detected, the tester will use capacitance to determine on which end of the net the error is locat-
ed. The tester will display the location on up to five errors. An asterisk indicates the error location on Error Reports. 

Note: With the Error Location option turned on, the test time will increase when an open or short error occurs 
as the tester performs the capacitance measurements required to determine at which end of the net the error is 
located.

External Start Switch

External Switch allows the tester’s digital I/O port to receive an input signal from an external switch to start a test. 
Use Pin 1 on the digital I/O connector for the external start switch. The external switch can be a foot pedal or a 
button.

● ON: The tester starts a test from the external switch signal.

● OFF: The tester does not look for the external switch signal.

Note: Turning “External Switch” on does not inhibit your ability to press START TEST on the tester display.

External Safety Switch

Safety Switch requires that the tester sees a high signal on pin 2 of the digital I/O connector before starting the 
hipot test. Safety Switch can be used to help ensure an operator does not shock themselves during a hipot test. 
Safety Switches can be dual palm switches wired in series, a foot pedal, or a sensor in automated test equipment.

● ON: The tester will look for a high signal on pin 2 of the digital I/O connector before starting a hipot test.

● OFF: The tester ignores the signal status of input pin 2 on the digital I/O connector.

Note: For more information on Digital I/O, see page 36. 
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9. Low Voltage

A low voltage test checks for shorts, opens, miswires and high 
resistance connections. The following settings control how the 
low voltage test is performed:

Connection Resistance 

This setting determines if the device passes or fails based 
resistance settings—i.e. connections with resistances measured 
above this value will fail.

● Range: 0.1 ohm – 5.0 M ohm

● As shown in the graphic below, connections measured
below or equal to the connection resistance value will pass
while any measurement above this value will fail. A resis-
tance measured above the connection resistance value,
but below the LV insulation resistance value, will be reported as a high resistance error. A measurement above
the LV Insulation Resistance Value will be reported as an Open error.

Connection 
Resistance

0.0 Ω ∞Ω
High ResistanceGood Opens

LV Insulation 
Resistance

Calculate Connection Resistance

This feature calculates the connection resistance from one or more sample cables. You can use this calculation to set 
an adequate connection resistance for testing.

LV Insulation Resistance

Isolation between nets that measures less than the threshold value results in a Short. Intended connections that 
measure above the LV insulation resistance value are considered Open during a low-voltage test (and ignored during 
a Learn). 

● Range: 0.1 ohm – 5.0 M ohm

● As shown in the graphic below, during a shorts test (checking for unintended connections), resistance mea-
surements above the LV insulation resistance value will pass. Any connections detected below this value will
be reported as a Short error.

Connection 
Resistance

0.0 Ω ∞Ω
Shorts Good

LV Insulation 
Resistance

Edit Low Voltage Settings

Connection Resistance:
5 ohm

Measured connection resistance below this value passes 
the low voltage test.

Calculate a connection resistance threshold based on 
one or more sample cables. 

Calculate Connection 
Resistance

Measured insulation resistance above this value passes 
the low voltage test.

LV Insulation Resistance:
100 k ohm

OK Cancel
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Component Resistance 

This value is only used when there are components in the test and is auto-set during the Learn process. It should be 
5-25% less than the lowest component found in the device being tested.

● Range: 0.1 ohm – 5.0 M ohm

● The following graphic shows how component LV settings define errors for intended connections if there are
components in the test. This value has no impact on whether an intended connection passes or fails, but does
influence whether a failing connection is labeled as High Resistance or Open.

Connection
Resistance

Component
Resistance

0.0 Ω ∞Ω
OpensGood

 LV Insulation
Resistance

High Resistance

● As shown in the graphic below, the Component Resistance value has no impact on the Shorts test.

Connection
Resistance

Component
Resistance

0.0 Ω ∞Ω
IgnoredShorts

 LV Insulation
Resistance



24 of 76 Cirris 4200 Series User Manual - 2020.4.0

10. High Voltage (Hipot) - 4250 only

High voltage or “hipot” testing is used to find defects and contaminants that could cause the cable to fail. 

WARNING: Read the Safety/Support section of this manual (page 4) before performing high voltage testing. For 
more ideas on high voltage safety, visit cirris.com/safety.

 10.1  High Voltage Testing 

High voltage settings can only be edited when high voltage is 
turned ON.

	● ON: The tester will perform a high voltage test after a suc-
cessful low voltage test. 

	● OFF: The tester will not perform a high voltage test.

	● Basic Settings: Adjust the basic high voltage settings 
you might find in your test specifications, such as voltage, 
insulation resistance, and dwell time. Other settings are 
automatically set accordingly.

	● Advanced Settings: Adjust individual settings for the Di-
electric Withstand (DW) test and the Insulation Resistance (IR) Test.

Note: Once Basic Settings or Advanced Settings have been changed, the button will turn green while the 
other button will turn blue. 

	● HV Options: Adjust other settings having to do with the high voltage test such as selecting which pins will 
be included in the test, whether a high-cap shield is present on the cable, and if you want to use high-speed 
mode.

 10.2  Basic Settings

High Voltage: Set the voltage limits required for your cable’s 
specifications.

Insulation Resistance: Set the resistance limits in order to 
measure your cable’s isolation. The measured insulation 
resistance must be equal or greater to the insulation resistance 
setting for the test.

Dwell Time: Set the amount of time the IR value must remain 
good to pass the test. The reported resistance value for the IR 
test is an average of the measurements taken over this time.

Edit High Voltage Settings

OK Cancel

High Voltage: ON

Hipot Settings

Basic Settings

Advanced Settings

Options

DW Voltage: 500 V
DW Max Current: 0.1 mA
DW Dwell Time: 10 mS
IR Voltage: 500 V
IR Minimum Resistance: 500 M ohm
IR Dwell Time: 2 mS
Soak Until Good: Off
Apply High Voltage To: All Adapter pins
Allow High-Cap Shield: No
High-Speed Mode: Off

Basic Settings

OK Cancel

High Voltage:
500V

Insulation Resistance:
500 M ohm

Dwell Time:
10 mS
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10.3  Advanced Settings

 10.3.1  Dielectric Withstand Test
In a Dielectric Withstand (DW) Test, a voltage much higher than 
the normal operating voltage is applied between points on the 
device-under-test. This ensures the wire insulation can withstand 
a higher amount of voltage (such as a surge) without failing. This 
test will also find near shorts, such as those caused by surface 
contaminants on connectors or wires that are almost touching.

DW Voltage: The voltage used for DW test. 

● Range: 50 VDC – 1500 VDC or 50 VDC - 2000 VDC de-
pending on the model.

● Optional AC:  As an option the 4250 can be equipped with the capability to perform DW testing using from 50
- 1000 VRMS, at 25, 30, 50 or 60 Hz.

DW Max Current: The maximum leakage current allowed during the DW test. 

● Range: 0.1 mA – 1.5 mA

DW Dwell Time: The amount of time voltage is applied during a DC DW test. For a DW test performed using AC 
voltage, the duration of the test is controlled by the Cycles parameter and the DW Dwell Time has no effect. 

● Range: 10 mS – 120 S

DW Mode: On 4250 testers equipped the AC option, toggle between DC and AC

AC Frequency: Only active when AC is selected as the DW Mode.

● Range: 25, 35, 50 or 60 Hz

Cycles: Controls the duration of DW tests performed using AC voltage. (Note: The DW Dwell Time parameter has no 
effect on AC DW tests.) 

● Range: 1, 10, 60, 300, 3600 or 7200 Cycles. Duration time is dependent on the chosen frequency which speci-
fies the number of cycles per second.

 10.3.2  Insulation Resistance Test
An Insulation Resistance (IR) Test measures the overall electrical insulation resistance to ensure that it meets the 
specified value. For a cable to pass the IR test, the measured insulation resistance must be equal or greater than 
the insulation resistance setting for the test.

IR Voltage: The DC voltage used for the IR test. 

● Range: 50 V – 1500 V (up to 2000V on testers equipped with the extended range)

IR Minimum Resistance: Minimum resistance needed for insulation to pass the test. 

● Range: 5.0 M – 1000 M ohm

IR Dwell Time: The amount of time the IR Resistance value must remain good to pass the test (this is how long the 
test will run after soak time). The reported resistance value for the IR test is an average of the measurements taken 
over this time.

● Range: 2 mS – 120 S

Advanced Settings

OK Cancel

DW Voltage:
500 V

DW Max Current:
0.1 mA

DW Dwell Time:
10 mS

DW Mode:
DC

AC Frequency:
60 Hz

IR Voltage:
500 V

IR Minimum Resistance:
500 M ohm

IR Dwell Time:
2 mS

IR Soak Time:
0 S

Soak Until Good: Off

Insulation Resistance (IR) TestDielectric Withstand (DW) Test

Cycles:
1 Cycle
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Note: Because the reported value is an average, this setting can also be used to filter out noise caused by 
the AC power coming into the tester. For the highest test accuracy, use an IR dwell of at least 17 mS to filter 
out 60 Hz noise and 20 mS to filter out 50 Hz noise.

IR (Max) Soak Time: The amount of time that the tester applies voltage before performing the final IR measurement. 
The test can be configured to soak for a period, or until the IR test passes. This setting is useful in humid 
environments or when the cable insulation has problems with dielectric absorption. 

	● Range: 10 mS – 120 S

Note: When an IR Max Soak Time is set, the tester continues to monitor the dielectric withstand current. If the 
dielectric withstand current is exceeded, the tester reports a “Dielectric Failure”.

Soak Until Good: Applies a voltage to the cable until the tester measures IR values that exceed the IR minimum 
resistance  or reaches the IR (Max) Soak Time.

	● ON: Applies voltage until the tester measures IR values that exceed the IR minimum resistance (i.e. could take 
less time than Max Soak Time).

	● OFF: Always applies voltage for duration of IR (Max) Soak Time.

 10.4  Options

Apply High Voltage To: This setting determines which test points 
get high voltage applied to them during the high voltage test. 

	● All Adapter Pins: All test points in the tester interface con-
nectors will be included in the test, regardless of whether 
they have connections to other points in the test.

	● Connections Only: High Voltage is applied only to test 
points that have connections defined in the test program.

Allow High-Cap Shield:  This option allows the user to continue 
high voltage testing a device that would normally fail the test due 
to a single over-current error. This error is presumed to be caused 
by a highly capacitive shield around the device. 

	● YES: Test continues with a single over-current error.

	● NO: Test fails when any error occurs, regardless of the cause.

Note: High Cap Shield is available to assist with highly capacitive shields, which would fail with standard high 
voltage settings. By turning on the High Capacitance Shield setting you can successfully test a cable with a 
high capacitive shield.

High-Speed Mode: The HV test applies a voltage to multiple nets simultaneously while still ensuring that each net is 
tested against every other net, thus speeding up the test process. If an error is found, each net is tested individually 
to locate the exact net that has the error. 

	● ON: Tester applies HV to nets in groups for faster testing.

	● OFF: Tester applies HV to each net one at a time while all other nets are pulled to ground.

WARNING! High-Speed Mode used on highly capacitive devices can slow testing. Highly capacitive nets may 
cause over-current failures, meaning the nets will need to be tested individually. This could cause the test to 
slow significantly.

High Voltage Options

Apply High VOltage To:
All Adapter Pins

Allow High-Cap Shield:
No

High-Speed Mode:
Off

Apply high voltage to all adapter pins, or just to pins included 
in nets.

Allow one highly capacitive net, such as a shield, to pass the 
high voltage test.

Employ an algorithm to speed the HV Test, but still ensure 
every net is tested to every other.

OK Cancel
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11. Reports
The 4200 Series testers can output the following reports and labels:

Run Report: The Run Report provides a results summary for the 
units tested in a test run including the number of Good, Bad and 
Total units tested. A “Run” is the test session that starts when an 
operator selects the Test button on the Main Menu and ends 
when the tester is returned to the Main Menu by selecting Done 
on the test screen. The report prints when the test run ends.

Batch Test Report: The Batch Test Report is similar to the Run 
Report except that it includes only the number of Good units 
tested. The report is often provided to customers as evidence of 
testing. The report prints when the test run ends by returning to 
the Main Menu.

Test Report: The Test Report is a detailed record for a single unit 
that passed a test and can also be sent to customers. The report prints after the tested unit is disconnected from the 
tester.

Error Report: The Error Report provides a detailed error description for a single unit that failed a test. This report is 
often used for reference when reworking assemblies. The report prints after the tested unit is disconnected from the 
tester.

Fail Label: Prints a “Failed” Test Label for labeling a device after it has failed a test. The label prints when the device 
is removed from the tester.

Pass Label: Prints a “Passed” Test Label for labeling a device after it has passed a test. The label prints when the 
device is removed from the tester.

To add reports to a test program: 
To add

1.	 With the test loaded, from the Main Menu > Edit > Reports 
> Add.

2.	 On the Add Reports screen, use the drop down box to 
select a report and tap the Add box to add it to the test 
program.

3.	 On the Report Settings Screen, use the drop down box 
to select the printer to which the report will be printed. If 
the tester is connected to the Cirris Hub, there will be a 
choice of two network printers in addition to the two local 
printers. It should be noted that the Hub allows the user to 
specify Print to Pdf as one of the Network printers, which 
enables the tester to save a .pdf version of the report to 
the Reports Directory specified by the Hub.  

4.	 Press OK to save.

Reports

OK

Cancel

Add

Edit

Remove

Run Report
Reports:

Report Settings

OK Cancel

Run Report
Report

<RunReport.cprn>
Template

Network 1 On End Test Run
Printer Auto Print On Event:
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11.1  Editing Report Templates
The default report and label templates included with the tester can be edited but new templates cannot be added. 
To access the templates, with the tester turned off, but still connected to power, connect a PC to the tester using a 
USB cable. In Windows File Explorer, the internal memory of the tester will appear as the drive named “4200 SERIES 
(X)” where “X” is the drive letter assigned by Windows. Make sure under the View tab that the Hidden items box is 
checked so that hidden folders and files are visible. The templates can be found under the path: X:\~Cirris\System\
Reports.

Tokens are used to add variables to reports and labels. The available tokens are listed in Section 11.1.3 below and 
appear in the templates within brackets, which is the required syntax (e.g. {TestStatus} for the Test Status token). Text 
not within brackets is fixed output meaning the text appears in the report or label as it appears in the template. If the 
data for a variable field is not available, it will be left blank on the report or label.

 11.1.1   Report Templates
The Report Templates are designed to print on size A paper (8 1/2” x 11” letter / 216 x 279 mm) or to .pdf files. 
There are four templates. To edit a report template, open it in an editor like Notepad. The templates are simple text 
so making changes is very straightforward. For example, to remove a line from the report simply delete it in the 
template and save the file to the tester overwriting the original version.

RUN REPORT

{TestName}
Date: {Date}, {Time}
Operator: {Operator}

Cable Signature: {DeviceSignature}
Parameter Signature: {ParamSignature}

Cable Serial Number: {DeviceID}

Adapter Signature(s):
{Adapters}

Parameter Settings:
{Parameters}

Connections:
{Connections}

Components:
{Components}

GOOD CABLES TESTED: {PassedCount}
BAD CABLES TESTED: {FailedCount}
TOTAL CABLES TESTED: {TotalCount}

Notes:

BATCH TEST REPORT

{TestName}
Date: {Date}, {Time}
Operator: {Operator}

Cable Signature: {DeviceSignature}
Parameter Signature: {ParamSignature}

Cable Serial Number: {DeviceID}

Adapter Signature(s):
{Adapters}

Parameter Settings:
{Parameters}

Connections:
{Connections}

Components:
{Components}

GOOD CABLES TESTED: {PassedCount}

● Run Report (filename: RunReport.cprn)
● Batch Test Report (filename: BatchTestReport.cprn)

● Test Report (filename: TestReport.cprn)
● Error Report (filename: ErrorReport.cprn)
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Notes: 
The font size and style–such as bold–cannot be changed on reports. Capitalization can be used when 
needed for emphasis. This limitation only applies to reports printed from standard page printers. Label 
templates formatted using Zebra Designer V2, allow more flexibility.

To retrieve the original default template, delete the revised template on the tester. When the tester is next 
powered up, the default template will be restored.

 11.1.2   Label Templates
Default templates for pass and fail labels are included in the 
tester. They are designed to print on 3” x 1” label stock and 
include the test result (Passed or Failed depending on the 
label type), test program name, date, and time. The FAIL label 
also includes the error details. The “Passed” and “Failed” are 
fixed text and the other fields are variables added by using 
tokens. The design of the templates can be edited using 
the free Zebra Designer software, which would have been 
included with the printer or can be downloaded from the 
Zebra web site. The software allows tokens, images, and other 
elements to be added to the label templates. It’s also possible to change the size of the label stock.

{TestName}

Passed 
{Date}
{Time}

TEST REPORT

{TestName}
Date: {Date}, {Time}
Operator: {Operator}

Status: {TestStatus}

Cable Signature: {DeviceSignature}
Parameter Signature: {ParamSignature}
Cable Description: {DeviceDescription}

Cable Serial Number: {DeviceID}

Adapter Signature(s):
{Adapters}

Parameter Settings:
{Parameters}

Connections:
{Connections}

Components:
{Components}

Fourwire Kelvin Pairs:
{KelvinPairs}

SPC Data Collection:
{SpcSettings}

Notes:

ERROR REPORT

{TestName}
Date: {Date}, {Time}
Operator: {Operator}

Error Signature: {ErrorSignature}
Cable Description: {DeviceDescription}
Cable Serial Number: {DeviceID}

Low Voltage And High Voltage Errors:
{ErrorDetails}

An asterisk * shows on which side the 
tester senses the error. The 4250 shows 
error location for opens and shorts.
The 4200 shows error location for 
shorts only.
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It’s important to understand that the Zebra Designer label design files are saved with the “.lbl” filename extension 
but the label templates used by the tester have a “.prn” filename extension. Both file types have different formats 
and only files with a .lbl filename extension can be edited by the Zebra Designer software. To make a label design 
available to the tester, it must be printed to a file using the Zebra Designer software. The resulting file will use a .prn 
filename extension. The only two label templates available to the tester are named “FailLabel.prn” and “PassLabel.
prn” and these are the only two filenames that should be used when printing or transferring label templates to the 
tester for use as Pass or Fail labels.

To edit the PASS or FAIL label:

	● Install and open the Zebra Designer software.

	● Install the driver for your Zebra printer by selecting File > Install Printer. Select and install the correct qualified 
printer - DO NOT install the “EPL” version of printers.

	● New label designs can be created from scratch, but at least in the beginning it’s likely easier to start with an 
existing label design. To view and/or edit an existing label design, with the PC connected to the tester using a 
USB cable, and the tester powered off, open the label Pass or Fail source file in the Zebra Designer software. 
Remember, the tester will appear as a drive named “4200 SERIES (X)” where “X” is the drive letter assigned 
by Windows. The label source files can be found under the path X:\~Cirris\System\Reports\LabelSrc. The 
filename for the PASS design label is “SingleDevicePassLabel.lbl.” The filename for the FAIL design label is 
“SingleDeviceFailLabel.lbl.”

	● More detail can be found in the Zebra User Manual, but here are a  few tips for using the Zebra Designer 
software.

	○ Existing objects can be deleted by using the select tool to select the object and then the delete key on the 
keyboard.

	○ New fixed text or variables can be added by selecting the Text tool and clicking on the label. This will open 
the Text Wizard window. The content should be “Fixed text” even when using a Cirris variable and always 
use a Zebra font. Fixed text and a token can be used in the same text box as shown in the example below.  
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After selecting Finish the text box will be placed on the label where its location can be adjusted as needed. 
The content and font can be edited by right clicking on the object and selecting Properties from the fly out 
menu to reopen the Text Wizard.

	○ Images, such as a logo, can be added to a label by selecting the Picture tool and then clicking on label 
where the image should be placed. The Open dialog will open where the source file can be selected.

	● Important! When finished editing, select File > Print. In the Print dialog window, select the check box for Print 
to file. In the Print to file window that opens, navigate to the Reports folder (X:\~Cirris\System\Reports) and 
print to the file named FailLabel.prn or PassLabel.prn as appropriate to overwrite the exiting label template. 
The .prn files are the templates used for label printing on the tester. As an alternative, the .prn files can be 
printed to the PC’s hard drive and subsequently transferred to the tester to overwrite the default template 
file(s).

	● Edited or new Zebra Designer label design files, those files with a “.lbl” filename extension, can be saved to the 
PC hard drive or to the tester using a filename of the users choice as they are not used by the tester directly.

Note: To retrieve the original default template, delete the revised template. When you next turn on the 
tester, the default template will be restored.
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 11.1.3  Tokens

The following tokens are available for use on Reports and Labels.

Token Description

{Adapters} Position & signature of adapters in the test program

{Components} Components in the test program

{Connections} Connections in the test program

{Date} Date of test

{DeviceDescription} Device description can be added to test program in an editor (See Section 15.3)

{DeviceID} Serial number of device tested (can only be collected using the scripting option)

{DeviceSignature} Device signature automatically created by tester

{ErrorDetails} Low voltage & high voltage error details

{ErrorSignature} Error signature automatically created by tester

{FailedCount} Number of failed units in a test run

{KelvinPairs} 4-wire (Kelvin) pairs in the test program

{LotID} Data is available when Lot ID is set to ON in the test program under Preferences

{Operator} Operator can be entered under System Settings on the tester

{Parameters} Test parameters used in test program

{ParamSignature} Parameter signature automatically created by tester

{PassedCount} Number of passed units in a test run

{SpcSettings} Settings for optional Data Collection feature

{TesterID} Tester serial number 

{TesterType} 4200 or 4250

{TestName} Test program name

{TestStatus} Pass or Fail

{Time} Time of test

{TotalCount} Total number of units tested in a test run
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 11.2  Printing Reports & Labels

 11.2.1  Network Printing
The 4200 Series testers can print reports to any network printer using the Cirris Hub Software installed on a network 
PC. See the Cirris Hub Manual for more information.

 11.2.2  Local Printing
The 4200 Series testers are capable of printing both reports and labels locally.

Local Report Printing

To connect a full-page report printer to your tester, you must use a Serial-to-USB Smart Cable available as Cirris part 
number SER2-USB. Cirris pre-programs the cable for 4200 Series testers. This cable will allow local printing to a 
qualified printer.

Qualified Local Printers

	● Brother HL-L6200DW

	● Brother HL-5340D

	● HP LaserJet Pro M118DW

	● HP LaserJet Pro M203DW

	● HP LaserJet Pro M402N

Unqualified Local Printers

	● Brother HL-L2350DW

Local Label Printing

4200 Series testers can print labels using any Zebra Programming Language (ZPL) capable printer. The printer 
connects directly to one of the 4200 Series tester’s built-in serial ports using a one-to-one serial cable. 

Qualified Zebra Label Printers

	● Zebra GC420t (can be purchased from Cirris)

	● Zebra GX420t

	● Zebra GK420t

Note: Zebra also makes thermal direct versions of these printers which can be used for printing on 4-Inch 
wide thermal sensitive label roll. 

To purchase a qualified printer and the Smart Cable from Cirris, talk to your Cirris representative.

 11.2.3   Local Report Printers
To set up a qualified local printer, first connect the Serial-to-USB Smart Cable. The 9-position D-Sub connector on the 
cable can be connected to Serial Port 1 or 2 on the tester, the USB Type B connector to the printer and the power 
plug to AC power. If using more than one tester, it’s beneficial to use the same port on each tester for the report 
printer as test programs, which may be shared among the testers, specify the port to which reports are printed.
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From the tester’s Main Menu > System Settings > Local Print/Serial - select Printer / Serial 1 or Printer / Serial 2 for 
the port being used by the printer. On the Printer / Serial 1/2 screen:

	● On the Use port for drop-down box, select Printer.

	● On the Printer Type drop-down box, select Postscript/PCL5.

	● All other settings will be fixed.

	● Select Connect and follow the instructions on the screen.

	● When the connection has been successfully established, the Connect button will turn green and display 
Connected and the Make and Model fields will be populated with the printer information. A test page can be 
printed by selecting the Print Test Page button.

	● Select Done when finished.

 11.2.4  Zebra Label Printers
The process of setting up reports printers will be familiar to most users. However, setting up a Zebra label printer will 
be new to many. The Zebra Quick Start Guide and Users Guide are the best reference sources for information about 
the printers and their set up, but the following provides the tester-specific set up steps and includes some quick tips 
that may be useful.

	● The Zebra label printer may be connected to either of the serial ports on the tester using a one-to-one serial 
cable. If using more than one tester, it’s beneficial to use the same port on each tester for the label printer as 
test programs, which may be shared among the testers, specify the port to which labels are printed. 

	● The serial port being used for the Zebra label printer must be configured on the tester. From the tester’s Main 
Menu > System Settings > Local Printer/Serial > select the port to be used for the label printer. On the Printer / 
Serial 1/2 screen:

	○ On the Use port for drop-down box, select Printer

	○ For faster printing, try a higher Baud Rate such as 115200.

	○ Data Bits cannot be edited.

Printer / Serial 2

Done

Use port for: 

Baud Rate:
115200

Data Bits:
8

Parity:
None

Stop Bits:
1

Printer Postscript/PCL5

Connect

Print Test Page

Make:
Model:

Printer Type:
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	○ Parity should be set to None.

	○ Stop Bits should be set to 1.

	○ Set the Printer Type to Zebra by using the drop down list.

	○ When the parameters are set, select Connect to establish communication with the printer.

	○ With the tester connected and communication established, the Print Test Page button can be used to print 
a test label. Don’t be concerned if the test message prints partially off the label stock.

	● If using a thermal printer, the ribbon will need to be loaded before using the printer. If you’re unfamiliar with 
these processes, Zebra has very helpful, short videos on their web site that walk through both steps. 

	● To tell the Zebra printer what size labels are being used, press and hold the button on the top of the printer 
while it blinks once then after blinks twice, release the button. The label stock should feed to a tear-off position.

	● If your printer has been used previously with other equipment and you’re having difficulty with the printer, 
pressing and holding the button on the top of the printer until it blinks four times will return the printer to its 
default settings.

	● If creating a new Fail label from scratch, you may want to examine the Fail label file, filename FailLabel.prn, in 
a text editor first. The line that includes the {ErrorDetails} token has been edited to make the error text wrap 
through multiple lines if necessary. The Zebra Label Designer software will not add the characters needed to 
make this happen which makes it necessary to edit the FailLabel.prn manually using an editor like Notepad. 
The line may be edited something like the example below:

		  Original line:  ^FT23,96^A0N,20,19^FH\^FD{ErrorDetails}^FS

		  Edited line:     ^FO23,96^FB580,7,0,L,5^A0N,20,19^FH\^FD{ErrorDetails}^FS

The ^FB command is used to define a text field block for test.  The lines above show up to 580 horizontal dots 
(about 3 inches at 203 dpi resolution) will be printed on the label, and a maximum of vertical rows, zero space 
between lines, left (L) justification, and a 5 horizontal dots for the first line horizontal indent.

The ^FO, Field Origin, command orients this text block. 

Reference the Zebra ZPL II Programing Guide for more information on these commands.

Printer / Serial 1

Done

Use port for: 

Baud Rate:
115200

Data Bits:
8

Parity:
None

Stop Bits:
1

Printer Zebra

Connect

Print Test Page

Hint:  For faster printing, try higher
baud rates, and then press Connect.

Printer Type:

Make:
Model:
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12. Digital I/O

With digital I/O, the tester can start a test based on input from an external switch, such as a foot pedal. Through its 
outputs, the tester can also activate devices such as LEDs. 

The digital I/O port is located on the back of the tester. The pinout is as follows:

Pin Function Pin Function Pin Function

1 Input Switch LV Start 6 Output 11 Output

2 Input Switch HV Start 7 Output for good test 12 Power + 10 VDC, 100 mA max.

3 Input 8 Output for bad test 13 N/A

4 Input 9 Power + 5 VDC, 100 mA
max 14 Ground

5 Output 10 Output 15 Ground

To use the External Switch input, you must set the test program’s Start Condition to Press Button (with the test pro-
gram loaded, from the Main Menu > Edit > Preferences > Low Voltage Start > Start Button). 

12.1  Inputs

The 4250 tester has two inputs, pins 1 and 2. The low voltage input 
is on pin 1 of the digital I/O connector. If a DC +5 volt (logic high) is 
applied to pin 1, the tester behaves as if START TEST were pressed. 
You can use the DC +5 volt power source on the digital I/O connec-
tor to supply the DC +5 voltages through the switch circuit.  Make 
sure you wire your external switch so it is normally open. Do not 
apply an AC voltage to the input.

Example of Digital I/O input wired with start switch.
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 12.2  Outputs

The tester’s outputs are “sinking” (open collector) outputs. When 
activated they will connect (or sink) to ground, in effect turning ON 
the output circuit. The outputs can sink up to a nominal 24 volts at 
500 milliamps. To limit the output current, always ensure adequate 
resistance between power supply and the output. 

As an example, let’s say you want to light an LED to indicate a bad 
test. You will want to connect the LEDs to pins 8 (output for bad test) 
and 9 (+5V). The LED requires only 20 mA, so we can use the +5 DC 
volt supply on the digital I/O port to power the circuit. Use a resistor 
in series with the LED to limit the current going through it. How do 
you choose the resistor? The LED in this instance has a forward bias 
voltage drop of two volts; therefore, three volts must drop across the 
current limiting resistor. Knowing the voltage drop is three volts across 
the resistor and the desired current is 20 mA, Ohms Law can be used to determine the resistor value.  

V/I = R

3V/20mA = 150 Ohms 

In this example, you would use a 150 Ohms resistor to limit the current through the LED.

When a test completes, the tester will pull the output to ground allowing current to flow in the circuit, and the LED 
will turn on. If the test fails, pin 8 will be pulled low. Pin 7 will be pulled low when a test passes. These results will 
only activate when all tests finish (including after the intermittents test is complete).

 12.3  Cirris Test Language (CTL)
The Cirris Test Language (CTL) is not strictly related to the use of digital I/O, but users interested in Digital I/O might 
also appreciate the capabilities of CTL. CTL includes a series of English-like commands that enable communication 
from an external device with Cirris testers via a serial or USB interface. Using CTL commands, a wide range of tester 
functions can be controlled by an external application. For more information on CTL, see the Cirris Test Language 
User’s Guide.

Example of Digital I/O output wired with LED.
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13. Components (New test program only)

Components can be automatically added to a test program during the Learn process for a new test program. If not 
originally Learned, the test program can be edited with a text editor on a PC. The 4200 Series can Learn the follow-
ing components:

	● Resistors

	● Capacitors

	● Diodes

	● 4-Wire (Kelvin)

	● Twisted Pair (4250 only) – Checks for split pairs

	● Single Ended (4250 only) – With only one end of an 
assembly connected to the tester, using capacitance mea-
surements, the tester will learn and test which connector 
pins have wires connected to them.

Select the required component(s) to add it to the test program.

	● On: The component type will be Learned by the tester and added to the test program.

	● Off: The test program will not include the component.

The tester will learn the nominal value of resistors and capacitors within the learn range and set a default tolerance 
of ±10%. The pass/fail threshold for 4-wire tests and the test parameters for single ended tests will be automatically 
set by the tester. However, all these variables can be adjusted using the Cirris Hub editor or another editor such as 
Notepad (See Section 15.3). 

Learn Components Settings

OK Cancel

Learn Resistors:
Off

Learn Capacitors:
Off

Learn Four-Wire:
Off

Learn Twisted Pair:
Off

Learn Diodes:
Off

Single Ended:
Off

Component Learn Range Test Range

Resistors 0.1Ω - 100KΩ; (>100KΩ -5MΩ learned as links - can 
be edited) 

0.1Ω - 1MΩ

Capacitors 400nF - 100μF 5nF - 100μF ± 10% / ± .02nF (relative 
measurements to 10pF);

Diodes Common silicon diodes (Zener diodes leaned as 
a standard diode if zener voltage > 4V. The tester 
can’t learn or test germanium diodes, Shottky diodes 
and diodes in series with some resistors. These 
components recognized as opens and shorts.)

Same as learn + LEDs

4-Wire (Kelvin) 4200 — .005Ω - 10.0Ω ±2% / ± .005Ω
4250 — .001Ω - 10.0Ω ±2% / ± .001Ω

Same as learn

Twisted Pairs
(4250 only)

Min length 1 - 6 feet depending on electrical 
characteristics of twisted pairs. Min 3 wires in cable.

Same as learn

Single Ended
(4250 only)

Capacitance measurements are used to differentiate  
pins from wires. The user specifies the learn range - 
Single Ended Pins <5pF - 500pF; Single Ended Wires 
>5pF - 500pF.

Same as learn
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14. Edit Data Collection Settings

Data Collection is an optional capability of the tester. Three data 
sets are available when Data Collection is turned on in a test pro-
gram - Summary Data, Measured Values Data and Error Text Data. 

The following default fields are stored and included in each data 
set:

	● Run Number (sequence number that increments each time 
a test session occurs for a given test program)

	● Analyzer Serial Number
	● Cable Description (can only be added to a test program 
using an editor - see Section 15.3)

	● Cable Filename (test program filename)
	● Operator (if defined on tester)
	● Date and time tested

The Summary Data is saved when Data Collection is turned on. In addition to the default data it includes:

	● Total Tested
	● Total Good
	● Total Bad
	● Error Types Summary
	● Custom, per group (if stored using Scripting)
	● Custom, per Cable (if stored using Scripting)

The Measured Values data set includes the default data and the following:

	● Cable Number 
	● Net or Instruction Label
	● Net or Instruction Measurement

The Error Text data set includes the default data and the following:

	● Cable Number 
	● Error Number
	● Error Code
	● Error Text

When data collection is turned on, at the end of the test session, when the user returns to the Main Menu from 
testing, the data is automatically saved to one of three locations using a base filename of the tester’s serial number 
with a “.c_d” filename extension. The tester requires that a folder named “spc_data” exists in the target directory 
in order to save the data. The folder exists by default on the Cirris Hub and in the internal memory of the tester.  If 
saving data to a USB flash drive, the folder must be created on the root directory of the drive manually. 

	● If the tester is connected to the Cirris Hub, the data will be saved to the network (F) drive in the spc_data folder 
in the directory designated by the Hub.

	● If the Hub is not available, the tester will next look for a USB flash drive and if one is installed AND it includes a 
folder with the name “spc_data” in the root directory, the data will be save in that folder. 

Data Collection Settings

OK Cancel

Data Collection: Off

Measured Values: Off

Error Text: Off
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● If the Hub is not available and a USB flash drive is not installed, or the flash drive does not include a folder with
the name “spc_data” in its root directory, the data will be saved to the internal memory of the tester (C drive).
The file can be accessed by connecting a PC to the tester using a USB cable and with the tester turned off, but
connected to power, the tester’s memory will appear as a USB flash drive in Windows File Explorer. With View
> Hidden Items turned on, the data file can be found under the X:\~Cirris\Spc directory.

14.1  SPC Link
The saved data file can be viewed in a text editor, but the Cirris SPC Link application is typically used to manage 
the data. The application will import the saved data from the “.c_d” file and can export that data to tab delimited or 
comma delimited text files so it can be readily imported to other applications such as Microsoft Excel.
The installation for the SPC Link software can be found on the USB flash drive supplied with the tester. The installa-
tion is a straightforward process that can be accomplished by following the instructions on the screen. When finished 
a shortcut will be placed on the Windows Desktop. 

 14.1.1  Importing Data
The Main Menu of the software is very simple with 
only a few options. To retrieve the saved data, select 
Import from Data Collection Files.

On the window that opens, using the Browse button 
navigate to the spc_data folder where the .c_d data 
file is stored. If the data file is stored on a network 
drive using the Hub, the path for the spc_data folder 
can be found on the Hub Interface Server Status 
page under the heading Data Collection.  When 
ready, select Read to import the data in the specified 
folder.

The Importing SPC Data window will open and the status bar will show the progress. Select OK when the import is 
complete.
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 14.1.2  Exporting Data
After returning to the SPC Link Main Menu, select Export to a Text File to export data to a comma delimited or tab 
delimited file. To export the data, in the Export Data to a Text File window:

	● Begin by setting a Date Range filter. Data sets available for testing performed within the specified range will 
appear in the Cable List 

	● Select the Filename for the test program of interest in the Cable List and then select (mark) Test Group(s) to 
include in the export.

	● Select the file types to be exported. The options include Measured Values (.MVF), Error Text (.ERR) and Sum-
mary Data (.SUM). The availability of the data will depend on the data collection preferences specified in the 
test program. The data for each will be exported to a separate file using the filename “EXPORTDATA” and the 
extensions referenced above (.MVF, .ERR and/or .SUM). The Change buttons allow the user to select the fields 
included in the export. The default is to include all the fields.

	● Select the preference for a Tab Delimited or Comma Delimited export format.

	● Use the browse button to select the directory to which the data will be exported.

	● When ready, select Write to export the data. 

	● The data in the exported files can be readily imported into Microsoft Excel or other applications for analysis. 
Keep in mind that the .MVF, .ERR and .SUM filename extensions won’t allow the file types to be automatically 
recognized as comma delimited or tab delimited files by Windows and for that reason it may be necessary to 
change the import file type category to “All Files (*.*)” when importing the data into an application.
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15. Perform a Learn

 15.1  Perform a Learn
The 4200 Series tester creates test programs by scanning a cable and forming a list of instructions based on the 
cable and test settings. 

1.	 From the Main Menu > Create New to access the Create New Test screen.

2.	 After editing the Learn settings, make sure the cable is attached and press Learn Attached Device. The tester 
will scan the attached cable and create a test program.

Note: If there were any errors during the Learn, you will be alerted with a Learn Failed notification. Check 
the Learn/Test settings for errors. Also check the cable that was used during the Learn. Once you have made 
adjustments to either the settings or the cable, press Learn Attached Device once more. If the Learn fails 
again, repeat this process to find the cause of the failure.

3.	 In the Learned Test Program window, verify the test instructions match the required specifications.  
If the test program is correct, select one of the following options:

	● Save: By pressing Save, the tester will name the test pro-
gram “NewTest.wir” and will store it in a default location. 
The next time a Learn is performed, selecting Save will 
overwrite the test program saved in the default location. 

If you save the test location in the default location, the test 
program will be overwritten the next time you press Save when 
creating a new test program.

	● Save As...: By pressing Save As, you will be able to select a 
storage location and name for the test program.

a.	 Navigate to a location within the directory to save the 
test program. If you are using Cirris Hub Software, you 
can choose a location on the network. This will allow other networked testers to use the test program as 
well.

b.	 To name the new test program, select New... and type in a name and press Done.

Once you have selected a location, you will be brought to the same location where the test was saved the next time 
you save or load a test.

	● Cancel: Return to the Learn screen without saving.

If the test program is not correct, press Cancel to return to the Learn menu. From there you can adjust the test 
settings and perform a new Learn.

Verify and Save Learned Test Program

Cancel

Learned Test Program
(A93484-00000

J1 03FAC1
J2 03FAC1

CONNECTION RESIS 10.0 ohm
LV INSULATION RESIS 100 K ohm
DWV VOLTAGE 300 V
DWV MAX CURRENT .1mA
INSULATION VOLTAGE 300 v
INSULATION RESIS 10.0 M ohm

C:\NewTest.wir

Save Save As...
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 15.2  Edit a Test Program

Load an existing test program and select Edit. The settings that 
can be edited are the same as those explained in the previous 
sections. Alter the specifications for the Test Program, including:

	● Preferences

	● Low Voltage

	● High Voltage (Hipot) – 4250 only 

	● Reports

	● Digital I/O

	● Components

	● Data Collection (an optional feature)

Components cannot be revised at this point on the tester. If you need to revise components, you can edit a test 
program using a text editor on a computer. One way to do this is using Cirris Hub Software (see page 15).

After revising a test, you have the option to Save, Save As, or Cancel the changes. 

	● Save: Saves the test program with a default name and location and returns to the main menu.

	● Save As: Allows you to choose a name and location for the test program. 

	● Cancel: Return to the previous  screen without saving.

 15.3  Edit Test Programs on a PC
Test programs can be edited using the Cirris Hub or by using an editor such as Notepad. Common reasons to edit a 
program include adding LABELS or revising the pass/fail tolerance of components.

If test programs are being stored on a network drive using the Cirris Hub, navigate to the desired test program under 
the File Management page of the Hub software. Double-click on the file to open it in the Hub editor.

To access test program files from a PC if the programs are stored on the internal memory of the tester:

1.	 Using the provided USB cable, connect the tester to a PC. Make sure power is supplied to the tester but that the 
tester is turned OFF.

2.	 When powered off and connected to a PC, the tester will behave like a flash drive. In Windows File Explorer, the 
memory of the tester will appear as a drive named “4200 SERIES (X)” where “X” is the assigned drive letter. 

3.	 Files can be moved to the PC using standard Windows copy and paste functions or test programs can be edited 
without transferring them to the PC by opening the file in a text editor such as Notepad. Files that were moved to 
the PC and edited must be saved then copied back to the tester. Programs edited on the tester simply need to 
be saved. In either case, edited programs would be available when the tester is disconnected from the PC and 
powered on. 

4.	 After editing the test program, turn on the tester. Load the edited test program. From the Main Menu press View 
to see the changes to the test program. 

Edit Test Settings

Save Save As ... Cancel

Preferences

Low Voltage

Data Collection

High Voltage (Hipot)

Reports

Digital I/O

Loaded Test: NewTest

Preferences
 Low Voltage Start: Start Button
 High Voltage Start: Start Button
 Intermittents Test: For Duration
 Intermittents Test Duration: 2 S
 External Start Switch: OFF
 External Safety Switch: OFF
 Error Location: ON
Low Voltage
 Connection Resistance: 5 ohm
 LV Insulation Resistance: 100 k ohm
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 15.3.1  Sample Test Program

*NightHawk001

(D512F2-MULTI

 J1  03FAC1
 J2  F5B4E0

WIRE LIST SIGNATURE:1A3A18-JD8M0
INSUL TEST PARM SIGNATURE:8L6FH
CONNECTION RESIS  10.0 ohm
COMPONENT RESIS >  228 ohm
LV INSULATION RESIS  100 K ohm
HIPOT VOLTAGE 300 V
INSULATION RESIS  10.0 M ohm
HIPOT DURATION  .01 SEC
HIPOT SOAK TIME  0 SEC
APPLY HIPOT TO ALL ADAPTER PINS

1   J1-001  J2-001
2   J1-003  J2-021
3   J1-005  J2-006
    J2-007
4   J1-007  J1-008
5   J1-009  J1-010

CHECK COMPONENTS
1 Diode J2-003 J2-010
2 RESIS J1-009 J2-024 301 ohm 10 %
3 CAP J1-021 J1-024 22.1 uF 10 %

LABELS
J1-001 = P1-01
J1-002 = P1-02
J2-001 = P2-01
J2-002 = P2-02

*Version:4
*TEST PREFERENCES
*START CONDITION: START BUTTON PRESSED
*INTERMITTENTS TEST: FOR DURATION 2 S
*HIPOT START CONDITION: AUTOMATIC
*HIPOT DELAY 0.2 S
*HIGH SPEED HIPOT: OFF
*EXTERNAL SAFETY SWITCH: OFF
*EXTERNAL START SWITCH: OFF
*ERROR LOCATION: ON

*Version:4
*REPORTS
*Test Report{<TestReport.cprn>, Printer, 
Network:1, TestPassed, On}

)

Filename: 25X2DIV.wir

This test program was created by learning a sample product on a 4250 
tester and then was edited to add a Cable Description & Labels. 

Location and signature of adapters. Can be edited but must match setup.

The Nets section includes a list of net numbers followed by a string of points 
in that net. Continuity tests will be performed between the points in each net. 
The tester also uses the net list as the basis for configuring low voltage (LV) 
insulation resistance (isolation) tests and high voltage (hipot) tests. The Nets 
section can be edited but it must match the device under test.

The CHECK COMPONENTS section lists components included in the test.
	● The Signature Diode test parameters cannot be edited. The first point 

designated is the anode side (J2-003 in the example).
	● The nominal value and the pass/fail percentage tolerance of resistor 

(RESIS) and capacitor (CAP) tests can be edited.

The tester uses the location of the adapters (J1, J2 etc.) and the pinouts of 
the connectors on the adapters to determine the default descriptions for test 
points. Preferred point descriptions (labels) can be used instead by adding 
a LABELS section to the test program in an editor. The labels will be used by 
the tester in error messages and in reports. Although it’s not necessary, the 
LABELS section typically includes all the positions in each of the connectors. 
See the next page for label rules. Helpful hint - when in the test mode on the 
tester, the unit’s probe can be used to identify test points.

The Test Parameters section includes both (a) values selected by the user on 
the tester before learning a sample product or subsequently by editing the 
program on the tester and (b) values assigned by the tester. The tester assigns 
the wire list signature, the test parameter signature and the components 
resistance value. The signatures need not be edited and it’s typically not 
necessary to edit the component resistance (see Section 9). Although it’s 
often easier to change the remaining settings on the tester, they can be 
edited, but must match the values available on the tester.

The TEST PREFERENCES section includes selections made when learning or 
editing a test on the tester under the Preferences menu. Although it’s typically 
easier to make changes to these variables on the tester, revisions can be made 
in an editor, but they must match selections available on the tester.

If reports were added to the program prior to learning the product or 
subsequently by editing the test program on the tester, the preferences 
selected will be included in the REPORTS section. Although this section can 
be edited, it’s recommended that changes be made using the tester.

The closing parenthesis signifies the end of the program.

The opening parenthesis signifies the beginning of the test program. The 
program signature is assigned by the tester and it need not be edited.

The filename is the name used to save the program on the tester.  It can be 
changed in the Hub editor or by using “Save As” in an editor like Notepad.

The optional Cable Description can be only be added in an editor. The field 
is included in the default Test Report and Error Report templates and in data 
saved when using the optional Data Collection feature. The description must 
be proceeded by an asterisk symbol (*) and inserted before the opening 
parenthesis that signifies the start of the test program.
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 15.3.2  Rules for Labels
The following rules apply when adding a labels section to a test program.

	● The proper syntax for a label is the default description followed by the equals (=) sign and then the label.  
White space is optional (e.g. either J1-001=P1-001 or J1-001 = P1-001 is acceptable).

	● Labels can include the characters A-Z, a-z, 0-9, underscore (_), and hyphen (-). Spaces are not allowed within 
labels.

	● Labels can’t duplicate existing default descriptions.  For example, if J1-001 is a default description for a test 
point, it can’t also be used as a label. This includes any of its common substitutes like J1-01 or J1-1. Suggestion - 
use an underscore as the leading character in the label (e.g.  _J1-001).

	● It’s not necessary to include labels for all positions in each connector. However, if an error occurs involving a 
position without a label, the default test point description will be used.

	● The maximum length of a label is 30 characters.

 15.3.3  Legacy Testers

On legacy Cirris testers such as the 1100 Series, some test preferences were controlled on a tester level. This 
means changes affected all test programs globally. On the 4200 Series, settings are controlled on a test-by-test 
basis. If one program is changed, it has no effect on other test programs.

These preferences include:
•	 Test start condition
•	 HiPot start preference
•	 Intermittent testing
•	 High Speed HiPot On/Off
•	 External Switch On/Off
•	 HiPot Safety Switch On/Off
•	 Error Location On/Off
•	 Report Printing
•	 Digital I/O

In the sample program on the previous page, notice that a 4200 Series test program includes a section of 
“preferences” near the bottom of the file including Test Preferences, Reports Preferences (if any were selected) and 
Digital I/O Settings (if any were added). These settings reflect selections made while creating or editing the program 
in the 4200 user interface. When running a test program created on a 4200 tester on an 1100 unit, the 1100 will ignore 
this section of the test program and instead defer to the global settings configured under the tester’s Preferences 
menu.
Also see Section 21 for Legacy Settings.
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16. Run a Test
The tester performs three tests in the following order:

● Low Voltage Test: Tests for continuity and basic isolation.
● High Voltage Test – 4250 only: Tests for thorough isolation.
● Intermittents Test: Tests for intermittent errors that could arise while the cable is being moved.

Test Window Overview

The test window displays user instructions, test results, and other information.

User Instruction/Test Status: The box at the top of the screen 
displays instructions for the user or shows the status of the 
tester. For example, if the wrong adapters or no adapters have 
been inserted when the test is started, this box will display the 
signatures for the correct adapters.

Test name: The name given when the test program was created 
will display here.

Start Test button: This button is active when the Start Condition 
is set to Start Button.

Abort button: Ends test at any point. The aborted test will not be 
recorded as though it were never tested.

Lot: The Lot ID will act as an identifier to the batch of cables being tested. If turned off, the space next to Lot ID will 
be left empty.

Good/Bad/Total: Tracks number of cables tested including how many cables passed and failed. 

Print: Press button to print test results if a report was selected for the test.

Test Results: This box will display one of three statuses:

● Not Tested
● Passed
● Failed

Result Details: Passes, fails, and error details from each test (Low Voltage, High Voltage, Intermittent) will appear in 
this window including error details.

16.1  Perform a Test

1. From the Main Menu, verify the required test program is loaded (the name of the test program is found at the top
of the main menu screen) and then press Test.

2. If Lot ID is turned on, you may be prompted to enter an identifying series of numbers or letters. The Lot ID will be
used to identify the batch of cables being tested. For more information on Lot ID, see page 27.

3. Depending on the chosen Start Condition, attach a cable or press Start. (The bar at the top of the window will
prompt which action to take.)

Ready to Test

Not Tested
Start Test

Abort

Print

Done

Lot:
Passed: 0
Failed: 0
Total: 0

Test: NewTest



Run a Test 47 of 76

 16.1.1  Low Voltage Test

4.	 The tester will perform a low voltage test, checking for opens, 
shorts and test any components included in the test program. 
For some cables, this test can take less than a second. Don’t 
be alarmed if the test passes without ever seeing the Low 
Voltage testing screen.

5.	 When the low voltage test finishes, either the intermittents 
test will begin, or if you are using the 4250, a window will 
prompt you to begin the High Voltage (Hipot) Test (if a High 
Voltage test was included in the test program). 

 16.1.2  High Voltage Test – 4250 only
6.	 Depending on the chosen start method, press Start Test or 

wait for the test to automatically begin.

WARNING! To prevent an electrical shock to the operator, do 
not touch the assembly during the high voltage test. 

7.	 The tester will perform a high voltage test, checking for 
current leakage and dielectric failures.

8.	 When the High voltage (hipot) test finishes, the Intermittents Test will begin (if an Intermittents Test was included 
in the test program). 

 16.1.3  Intermittents Test
9.	 The Intermittents Test allows the user to check for potential 

defects by flexing or otherwise stressing the cable while the 
tester continuously checks continuity and isolation. If any 
failure is detected — even momentarily — the test will fail.

Note:  If Press to Stop was the program option selected to 
end the Intermittents Test, and the DUT is removed before 
End Test is selected, the test will fail. Likewise, if For Duration 
was the option selected, and the DUT is removed before the 
specified time elapses, the test will fail.

Testing...

Not Tested
Start Test

Abort

Print

Done

Lot:
Passed: 0
Failed: 0
Total: 0

Test: NewTest

Testing High Voltage...

Not Tested
Start Test

Abort

Print

Done

Lot:
Passed: 0
Failed: 0
Total: 0

Test: NewTest

High Voltage (Hipot) Test

**  Caution - High Voltage **

Start Test Abort

Testing for Intermittents...4

Not Tested
Start Test

Abort

Print

Done

Lot:
Passed: 0
Failed: 0
Total: 0

Low Voltage Test: Passed
High Voltage Test: Passed

Test: NewTest
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 16.1.4  Finishing a Test

10. Upon completing the test(s), you may want a printed report
summarizing the results. If auto-print was selected from the
System Settings menu, a report will print automatically, or
you can press the Print button to print the report (see page
27 for printing instructions).

11. If Cable Attached has been selected, remove the cable to
complete the test. The results of the test will remain on the
screen until the next cable is attached. The Lot information
will update  to show the results of the test.

12. At the end of the test—pass or fail—you have the option to retest the cable. Make any necessary adjustments to
the hardware and press Retest. Pressing Retest will remove the last recorded test from the Lot information. The
retest option is only available until the cable has been removed.

16.2  Test Results
Test results are displayed in the box on the right side of the screen. If an error occurred, the details of the error will be 
displayed. See page 44 to learn about interpreting test results.

16.3  Printing Reports
In order for reports to print, the report must be added to the test program during setup.

When you press the Print button, a list of available reports will appear in a window. Select the report you wish to print 
and press OK.

If Auto-Print is set up, the report will print automatically upon the predetermined event.

16.4  Using the Probe
In the test window, probe any point on the attached connector to show information pertaining to the probed point. 
Release the probe to hide the window. This will help you locate errors within the cable.

Ready to Test

PassedTest: NewTestStart Test

Abort

Print Done

Lot:
 

Passed: 1
Failed: 0
Total: 1

Test: NewTest

Low Voltage Test: Passed
High Voltage Test: Passed
Intermittents Test: Passed 276 Cycles

Ready to Test

Passed
Start Test

Abort

Print

Done

Lot:
Passed: 1
Failed: 0
Total: 1

Test: NewTest

Low Voltage Test: Passed
High Voltage Test: Passed
Intermittents Test: Passed 276 Cycles
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17.  Interpreting Test Results
When an assembly fails a test, the Test window will display the error type and the test points / nets involved in the 
error. The following examples show frequent errors operators may encounter:

Error Tones
When the start condition is set to Cable Attached and the volume is turned up, a failed cable will cause an error tone. 
The tone will change depending on the type of error. It will keep playing until the cable is removed. This feature can 
be useful during assembly when working with open and miswire errors.

Error Location
If you have an open or a short, the tester will use capacitance to determine on which end of the net the error is locat-
ed.  The tester will display the location on up to five errors. An asterisk indicates the error location on Error Reports.

Error Signature
Use error signatures to recognize previously encountered errors and test partially-built devices. Error Signatures dis-
play in the test window during a failed test.. 

Low Voltage Errors
Low voltage errors identify errors in the cable wire pattern. When 
the tester detects a low voltage error, the screen will display de-
tailed information about the error.

The first line shows that the low voltage test failed.

The second line describes the type of error.

	● OPEN: The intended electrical path contains a gap across 
which electric current cannot pass. 

	● SHORT: An unintended connection between 2 or more 
points. This failure indicates insufficient insulation between 
unintended connections. 

The third line defines the location of the error. For example, the 
above image shows an Open error between test points J1-001 and J1-014.

In the case of a miswire, a fourth line will provide the third point in 
the error. 

	● MISWIRE: An unintended connection which is the result 
of unexpected contact. This error is often referred to as an 
Open and a Short combined. 

The example to the right shows an Open error between test points 
J1-001 and J1-014 and a short from J1-014 to J1-002.

Component Errors
When the tester creates a new test program containing a compo-
nent, it will measure the component value in the sample device 
and assign a default tolerance range. During a test, if the tester 
measures a value outside of the tolerance range, the component 
instruction will fail with an error message that indicates the value 
measured, as well as the expected value.

Failed
Failed

Low Voltage Test: Failed
Error Signature: 5632A2-2J05H
     Net 1: OPEN
 J1-001 to *J1-014

Failed
Failed

Low Voltage Test: Failed
Error Signature: F87F52-2J05H
     Net 1: OPEN
 *J1-001 to *J1-014
 MISWIRE to *J1-002
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Note: You can change the expected component value and the tolerance range by editing the test program in 
a text editor.

High Voltage Errors – 4250 only
Overcurrent Error: 

● An overcurrent error occurs when the current has exceeded an internal limit during the ramp phase for the net
or point given in the error message. This often means that there is an unintended connection in the device so
that more current is flowing than expected as the tester ramps up to the test voltage.

● This error could also be caused when the tester is charging the net or point given in the error message and the
capacitance in the DUT is too high. A limit is in place to ensure safety while testing, so testing is immediately
halted when the limit is reached.

Dielectric Failure Error:

● This error indicates that an arc occurred during the high voltage test to the net or point given in the error mes-
sage. This error will occur anytime the current exceeds the ‘DW Max Current’ test setting.

● This error most often occurs in pairs—Two different nets will fail. This generally means that the arc is occurring
between these two nets. If the error occurs only on a single net, it may be the result of a highly capacitive net
such as a shield. The 4250 tester has a setting that can overcome an error caused by highly capacitive shields.
See page 24.

Leakage Error	
This error is an indication that the measured insulation resistance is lower than specified by the IR Resistance test 
setting. 

HV Errors Graph
The graph represents a normal, good set of high voltage tests. The red line represents voltage while the blue line 
represents current. If the blue current line ever enters one of the pink regions, the specified error will result. You can 
see how high voltage errors, like those described above, occur during a high voltage test.
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18. Manage Files

All test programs, report templates, and other files can be ac-
cessed through the Manage Files menu. From this menu, test 
programs can be organized, copied, and deleted.

Filter files: Use the drop-down list to filter files. The *.* symbol 
shows all files.

Open a folder: Double-tap on a folder to open it.

Create a new folder: Press the New Folder button, type the name 
of the new folder, and press Done.

Return to the previous folder: Double-tap the top folder in the 
list showing the folder icon followed by two dots to return to the 
previous folder.

Copy a test program: Select a test program and press the Copy/Move button. Navigate to the folder where you wish 
to save the copied test program and press Copy. The test program can now be found in both the previous location 
and the new location. 

Move a test program: Select a test program and press the Copy/Move button. Navigate to the folder where you wish 
to save the test program and press Move. The test program will no longer reside in the previous location but will only 
be found in the new location.

Delete a test program: Select a program or file and press Delete. Confirm that you want to delete the program or file 
by pressing Continue.

WARNING! There is no recovery option after a test program or folder is deleted. Verify the file selected before 
you delete any files.

 18.1  Test Program Backup via PC Connection
By connecting your tester to a PC, you can move files to and from the PC like you would with a USB flash drive. This 
allows you to back up test programs, organize files, and customize labels and reports. 

1.	 Connect the PC to the tester using a USB cable.

2.	 Make sure the tester is connected to power but turned off. If the tester is running, you will not be able to access it 
from a PC.

3.	 In Windows File Explorer, the memory of the tester will appear as a drive named “4200 SERIES (X)” where “X” is 
the assigned drive letter. Accessing the tester’s memory provides the following capabilities:
a.	 Test programs can be organized into folders for easy access.

b.	 Test programs can be backed up to the PC.

c.	 Test programs can be edited using an editor like Notepad and saved to the tester’s memory.

4.	 When finished, remove the PC cable, or turn the tester back on. Either action will disconnect the tester from the 
PC. 

WARNING! Do not format your drive. Formatting your drive will permanently erase all test programs and test 
settings. If this happens, you must contact Cirris to make your tester operational again.

Manage Files

Done

*Double tap folder to open

Delete

New Folder

Copy / Move

NewTest.wir

C:\C: *
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18.2  Local Test Program Backup via USB Drive
To back up test programs using a flash drive: 

1. Insert a USB drive into the USB port on your tester.

2. Copy your test programs onto the USB drive.

3. Remove the USB. With the test programs on the USB drive, you can save them onto a PC for safe keeping or for
editing through a text editor.

Other USB drive uses:

● Update Firmware.

● Copy test programs between 4200 Series testers.

● Copy test programs between the tester and a PC.
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19. System Settings
•	

Various global settings and actions can be found under the 
System Settings Menu. Some of the items are self-explanatory 
while others require more in-depth descriptions that are provided 
in separate sections of the manual as noted below. 

Volume: Adjusts the volume of tester tones.

Date: Sets the date and adjusts the date layout.

Time: Sets the clock for local time and adjusts the clock layout.

Mains Frequency: Also known as Power Line Frequency, should 
be set to 50 or 60Hz depending on your country’s AC line 
frequency. The Correct selection will improve test measurement 
accuracy.

Operator:  If desired, the operator name or ID can be entered which would allow the tester to add the operator name 
or ID to reports and, if the Data Collection option is enabled, to saved data.

Legacy Defaults: Reproduces the 1100 Series behavior on a 4200 Series. See page 54.

Local Printer/Serial: Sets the function of the two serial ports and their associated variables.

Network Settings: Adjust network settings. For more information, see the Cirris Hub Manual.

Auto Start Test: The tester can be set to automatically start testing when the unit is turned on or when power is 
applied, which can be useful in some applications including automated test cells,

Activate Options: After purchasing a new, optional feature, enter the feature key provided by Cirris into this menu to 
add the feature. Optional features include:

● 1000-volt AC Dielectric Withstand (DW) test capability (DC DW test capability is a standard feature).
● LUA Scripting
● Data Collection
● PC-Control for use with the Easy-Wire software
System Diagnostic: On startup, the tester runs a self-test to verify that the system is functioning properly. If a problem 
with the tester is suspected, a self-test can also be started from the System Diagnostic menu. If the tester fails the 
self-test, a window will open with a description of the details of the failure. Note the details of the failure and contact 
Cirris Tech Support.

The System Diagnostic menu is also the starting point to Verify Calibration using a Performance Verification Kit 
available from Cirris. The Zero/5 Meg Ohm test, which is a subset of the calibration verification process, can also be 
performed separately starting from the System Diagnostic menu.  See the 4200 or 4250 Performance Verification 
Manual for additional information. 

About: Provides information about the tester configuration including:

● Station Name (Can be edited)
● Serial Number
● Firmware and Hardware versions
● Ethernet MAC
● WiFi MAC
Security:  Users can be locked out of specified functions, like editing a test, the 42XX Security Utility. See Section 23.

System Settings

Done

Volume:
20% Legacy Defaults Activate Options

Date:
MM-DD-YY

System Diagnostic

Time:
HH:MM:SS Network Settings About

Language: English

Mains Frquency:
60 Hz

Local Printer/Serial

Auto Start Test Security

Operator:
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20. Legacy Defaults
On legacy Cirris testers, such as the 1100 Series, some test preferences were controlled on a tester level meaning 
that changes affected all test programs globally. On the 4200 Series, these settings are controlled by the test pro-
gram and changing one program has no effect on others.

For example, on the 1100H+ testers, the HiPot Start Condition is a global setting configured under the Set 
Preferences menu. However, on the 4250 testers, this setting is specified in each test program as a preference within 
the program. The same is true of the following:

•	 Test start condition
•	 HiPot start preference
•	 Intermittent testing
•	 High Speed HiPot On/Off
•	 External Switch On/Off
•	 HiPot Safety Switch On/Off
•	 Error Location On/Off
•	 Report Printing
•	 Digital I/O

To use test programs from a legacy tester, set the Legacy Defaults on your 4200 Series tester to match the system 
settings of your legacy Cirris tester. Once a legacy test program has been edited and saved on a 4200 Series tes-
ter, the new test program settings will be applied. The same test program can still be used on a legacy Cirris tester 
with the legacy tester applying its own system preferences and ignoring the 4200 program preferences.

.

Preferences

OK Cancel

Start Button
Auto Start Delay:

1 S

Enter Lot ID: Off

Error Location:
On

External Safety Switch:
OFF

External Start Switch:
OFF

High Voltage Start:

For Duration
Intermittents Test Duration:

2 S

Intermittents Test:

Cable Attached
Low Voltage Start:
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21. Network Settings

In order to print to a network printer and/or to share test programs between 4200 Series testers, the testers must 
be connected to the Cirris Hub running on a PC. Instructions for installing the Cirris Hub can be found in the Cirris 
Hub Manual. 

All 4200 Series testers include networking capability. To connect the tester to the Hub over the network, from the 
tester’s Main Menu, select System Settings, and then Network Settings. The options on this screen will allow your 
tester to communicate with a network running Cirris Hub Software. 

Note: An IT professional will likely need to help you in setting up your tester network settings. 

Choosing between Ethernet or WiFi
Ethernet is the most reliable method for connecting your tester to the Hub network. Once you have entered the 
settings for Ethernet and WiFi, you may switch between one or the other by simply by changing the Mode in Network 
Settings. 

 21.1  Ethernet

Cirris suggests using Ethernet whenever possible to ensure a 
reliable connection.

Using an Ethernet cable, connect your tester to the same network 
router or switch that is connected to the PC running Cirris Hub 
Software.

On the Network Settings screen: 

	● Mode: Ethernet.

	● Server: IP address for the computer running Cirris Hub 
Software.

	○ The tester will automatically detect the IP address of the 
computer running Cirris Hub Software If the tester is on the same subnet.

	○ Enter the IP address or host name of the computer running the Cirris Hub Software if the network service is 
not detected. The IP address and the port can be found on the Server Status page of the Cirris Hub inter-
face. See the Cirris Hub Manual for more information.

	● Port: You do not have to enter a port if the tester automatically detects the Cirris Hub Server on its subnet. The 
default port is 12568 or enter the port number as set up by the IT administrator.

Press Done. The tester should say Connecting to Cirris Hub... then return to the System Settings screen. When you 
load a test from the Main Menu, you will notice that you can select F: drive.

Your tester should now appear on the list of available testers in the Cirris Hub Interface. See the Cirris Hub Manual for 
more information.

Network Settings

Cancel Done

None Refresh

EthernetMode:

SSID:

Enter Username

Pre-Shared KeyAuth Mode:

Username:

Enter PasswordPassword:

Enter Server Port

Enter Server IPServer:

Port:

Add CA Cert
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21.2  WiFi

Warning: When using WiFi, you may on occasion notice the tester pause to reestablish network 
communication. Cirris recommends using a wired connection.

1. On the Network Settings screen:

● Mode: WiFi

● SSID: Press Refresh then select the wireless network from the drop-down list.

Note: The name of the wireless network must be broadcast. The tester is not capable of connecting to a non-
broadcast wireless network.

● Auth Mode: Select Enterprise or Pre-shared Key depending on your network environment.

● Username: Enter the Username if using the Enterprise mode.

● Password: Enter the password to connect to the network.

● Server: Server: IP address for the computer running Cirris Hub Software.

○ The tester will automatically detect the IP address of the computer running Cirris Hub Software If the tester
is on the same subnet.

○ Enter the IP address or host name of the computer running Cirris Hub Software if the network service is not
detected. The IP address and the port can be found on the Server Status page of the Cirris Hub interface.
See the Cirris Hub Manual for more information.

● Port: You do not have to enter a port if the tester automatically detects the Cirris Hub Server on its subnet. The
default port is 12568 or enter the port number as set up by the IT administrator.

● If a client CA Certificate is required, insert a USB drive containing the certificate into the USB port on the back
of the tester. Press Add CA Cert to access the certificate.

Press Done. The tester should say Connecting to Cirris Hub... then return to the System Settings screen. When you 
load a test from the Main Menu, you will notice that you can select F: drive.

Your tester should now appear on the list of available testers in Cirris Hub Software. See the Cirris Hub Manual for 
more information.

 21.2.1  Connecting to Cirris Hub...
Depending on your environment, network, and other conditions, 
you may experience occasional pauses when using WiFi. These 
pauses can last several seconds while a window blocks the tester 
screen. Do not press cancel. Wait for the tester to connect to the 
network. Once the tester reconnects, the window will disappear 
and the test process can resume.

Network SettingsConnecting to Cirris Hub...

Initializing ...

Cancel
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22. Security

Using the 42XX Security Utility, selected functions of the tester can be locked to prevent users from accessing or 
specified functions. For example, operators can be prevented from editing and saving programs. 

The 42XX Security Utility is included in the 42XX Utilities installation 
provided on the USB flash drive supplied with the tester. The 
installation will place a shortcut on your desktop or the program can 
be accessed under the Cirris programs folder. To run the utility, first 
connect the PC to the tester using a USB cable and turn the tester 
on. Open the utility and follow the instructions on the screen.

On the 42XX Security Utility Main Menu:

	● The Connect / Disconnect button toggles between the two 
functions. Connect will place the tester in the remote mode 
and allow the application to send changes to the tester. 
Disconnect should be selected after preferences have been 
selected and the tester has been updated.

	● The Enable Security / Disable Security button toggles 
between these two functions. Enable Security will activate 
the Set up locks >> and Password buttons. Disable Security 
removes security settings from the tester.

	● Set Up Locks >> accesses additional screens on which 
specific functions to be locked can be selected.

	● A Password must be entered to enable security on the 
tester. The password can be used on the tester under 
Main Menu > System Setting > Security to temporarily 
provide access to functions locked by the security settings.

	● Update will send the new security configuration to the tester, locking the specified functions and updating the 
password.

The Locks Settings screen, accessed by selecting the Setup Locks>> button, has two tabs - Basic Settings and 
Advanced Settings. Most users will find the Basic Settings sufficient, but selecting any of the category buttons 
under either tab will present a list of check boxes used to select functions within that category to lock. 
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Under the Advanced Settings tab, options for saving selected Lock Settings and loading saved Lock Settings are 
also available.

Selecting the “Floppy Disk” icon on the Advanced Settings tab will allow the user to navigate to 
a desired file directory and save the current Lock Settings as a file.

Selecting the “Folder” icon under the Advanced Settings tab will allow the user to load a 
previously saved Lock Settings file.

When finished selecting lock preferences, select Done to return to the Main Menu. Enter a password and select 
Update to download the settings to the tester. Select Disconnect to return the tester to local control and close the 
Security Utility.

On the tester, buttons for locked functions now include a small closed padlock icon signifying those functions are 
inaccessible. To temporarily override the locks, on the tester from the Main Menu > System Settings > Security and 
enter the password created in the 42XX Security Utility. Functions previously locked will now be accessible and 
will show an open padlock icon. Reentering the password will revert to the original, locked security settings. Power 
cycling the tester will also reset the locked settings.

If the password is lost, a new one can be created by running the 42XX Security Utility again.

To permanently disable security settings and remove the lock icons, follow the same process described above to 
connect the tester to the PC and open the 42XX Security Utility. On the 42XX Security Utility Main Menu, select 
Disable Security and then Update before selecting Disconnect to return the tester to local control.
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23. High Voltage Guidelines (4250 only)
Use the following considerations to determine high voltage specifications:

	● Customer needs, engineering necessities, or manufacturer’s specifications for wires and connectors.

Note: Do not confuse the rated running voltage with a maximum hipot value.

	● Voltage applied to a cable which may be limited by the spacing between pins in a connector and the separa-
tion of the conductors in a cable.

	● Available high voltage selections for the Insulation Resistance Settings (see page 25) – see the table below.

	● Highly capacitive cables that the amount of high voltage that can be applied to the cable. 

HV Insulation Resistance Table
The “HV Insulation Resistance” settings are limited by the high voltage settings. The table below shows the available 
Insulation Resistance settings at each of the high voltage settings. 

Voltage Min IR (Megohms) Max IR (Megohms)

100 V 10 100

200 V 20 200

300 V 30 300

400 V 40 400

500 V 50 500

600 V 60 600

700 V 70 700

800 V 80 800

900 V 90 900

1000 V - Max 100 1000

HV Insulation Resistance Guidelines
IR Settings may be based on any of the following factors:

	● Contamination: Fingerprints and mold release on your DUT may require you to lower the IR threshold.

	● Humidity: A humid environment can aggravate the effects of contamination between contacts and affect insu-
lation.

High Voltage Duration: 
Insulation Resistance Duration may be set using the following guidelines:
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● The default setting of 0.010 seconds (10 milliseconds) should be adequate to test most cables. A longer dura-
tion will increase the high voltage test time.

● Since absorbed moisture may not have time to be “dried out” before the Insulation Resistance Test, consider
using the advanced Soak setting to “dry out” your insulation. A shorter soak time or not having soak time is
more likely to fail due to humidity related problems

Dielectric Withstand Duration

● A longer duration provides a more stringent test for predicting dielectric failures (exhibited as sudden arcs);
however, equivalent dielectric errors can be found by compensating a shorter duration with a higher high volt-
age setting.

● A longer duration may be better for predicting some types of insulation failures and may increase the chance
of detecting a breakdown condition.
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 24. 4-Wire Kelvin Testing
To measure resistance, the tester applies a current source to one test point in a net while it connects a second point 
in the net to ground and measures the voltage drop between the two. It then calculates the resistance using Ohm’s 
Law. Since voltage is measured through the fixturing, any resistance in the fixturing is included in the measurement. 
The 4-wire (Kelvin) test method eliminates the resistance of fixturing and also enables the testers to measure very low 
resistance values - as low as .001 ohm for the 4250 tester and as low as .005 ohm for the 4200 tester. 

 24.1  4-Wire Pairs
The 4-wire measurement method requires two test points for each termination in the device under test. These are 
called 4-wire pairs.

	● One test point supplies current (referred to as “force”) 

	● The other senses voltage (referred to as “sense”)

It’s necessary to use one force point and one sense point in each 4-wire pair. For the purpose of 4-wire testing, all 
positions in each Cirris adapter are EITHER a dedicated force point or a dedicated sense point. These identities can’t 
be changed.  Therefore, when making 4-wire fixtures or test cables, it’s necessary to know whether a position in an 
adapter is a source point or a sense point before wiring the fixture. This manual will describe the two types of points 
as Type 1 and Type 2, or T1 and T2, but you may also see tester messages that refer to the two types as A and B. 
Whatever the terminology, the important thing to note is that each 4-wire pair must include one of each type. 

Note: If a 4-wire pair is wired incorrectly, during the learn process the tester will display an error message 
indicating that both points in the specified 4-wire pair are the same type.

Although any Cirris adapter can be used for 4-wire testing, one of the easiest to use is the AHED series because 
the Type 1 and Type 2 points alternate side-by-side making it simple to identify proper 4-wire pairs as shown in the 
example of the AHED-16 adapter below. 

Helpful tip: When learning a new test program that includes 4-wire components, the learn is a two-step process.  The 
tester first learns the 4-wire pairs before learning the sample device. At the beginning of this first step, the tester will 
display the message “Attach Four-Wire Fixture.” At this point the tester’s probe can be used to identify points as Type 
A or Type B, the terms the tester uses to differentiate force and sense points. The probe can be used directly on 
adapter positions to differentiate the two types or on fixturing to check the point types.
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24.2  4-Wire Fixtures
When making 4-wire fixturing or test cables, it’s important to understand that 4-wire measurements includes only the 
resistance between where the source and sense points meet on both sides of the device being measured. This is 
very useful because it eliminates unwanted fixture resistance from the measurement. For this reason it’s most often 
beneficial for the source and sense points to meet as close to the device under test as possible. The graphic below 
shows a typical 4-wire test configuration in which the source and sense points meet in the contacts of the product 
mating connector. In this setup, there may be some small resistance in the receptacle contact from the point where 
the source and sense meet, but then only the mating resistance of the contacts and the resistance of the device 

under test is measured.

24.3  Creating a 4-Wire Test Program
To create a 4-wire test:

1. From the tester’s Main Menu > Create New.

2. From the Learn Menu, press Edit Learn Settings > Components.

3. In the Components Menu, press Learn Four-Wire and press OK to return to the Edit Learn Settings Menu. When
done making changes press Save to return to the Create New Test Menu.

4. With only the fixturing attached to the tester, press Learn Attached Device. A window will appear instructing the
user to Attach Four-Wire Fixture. When this window appears, the probe can be used to identify points as Type A
or Type B. When ready, press Learn to proceed with the learn process.

5. After the 4-wire pairs are learned, the tester will display a message instructing the user to Attach Four-Wire
Cable. Connect the sample device to the fixture/test cable(s) and press Learn to learn the device.

to tester

to tester

Device Under Test Fixturing
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 24.4  Viewing a 4-Wire Test Program

There are a few items to note when viewing 
programs resulting from a 4-wire learn. (C62C28-MULTI

 J1  D507F1

WIRE LIST SIGNATURE:6B1614-5N8N1
INSUL TEST PARM SIGNATURE:8L6FH
CONNECTION RESIS  10.0 ohm
COMPONENT RESIS >  90.0 K ohm
LV INSULATION RESIS  100 K ohm
HIPOT VOLTAGE 300 V
INSULATION RESIS  10.0 M ohm
HIPOT DURATION  .01 SEC
HIPOT SOAK TIME  0 SEC
APPLY HIPOT TO ALL ADAPTER PINS

1   J1-001  J1-003
2   J1-005  J1-031
3   J1-019  J1-023
4   J1-041  J1-042
5   J1-043  J1-045

CHECK COMPONENTS
1 4W_WIRE J1-001 J1-003 < 0.089 ohm
2 4W_WIRE J1-005 J1-031 < 0.044 ohm
3 4W_WIRE J1-019 J1-023 < 0.044 ohm

*Version:4
*TEST PREFERENCES
*START CONDITION: START BUTTON PRESSED
*INTERMITTENTS TEST: FOR DURATION 2 S
*HIPOT START CONDITION: AUTOMATIC
*HIPOT DELAY 0.2 S
*HIGH SPEED HIPOT: OFF
*EXTERNAL SAFETY SWITCH: OFF
*EXTERNAL START SWITCH: OFF
*ERROR LOCATION: ON

FOUR-WIRE KELVIN PAIRS
J1-001 J1-002
J1-003 J1-004
J1-005 J1-006
J1-019 J1-020
J1-023 J1-024
J1-031 J1-032

)

Filename: 4537908-501

Points in 4-wire instructions are also 
included in the Nets list as standard 
connections. This is required for the tester to 
perform accurate isolation tests

Only one point in each 4-wire pair will be 
shown in the instructions, the other will 
remain invisible. The tester will make the 
lower-numbered test point in each pair the 
visible point regardless of whether that point 
is a source or sense point. 

The tester will automatically set pass/fail 
thresholds for 4-wire tests based on the 
learned resistance values. The thresholds 
can be edited as required (see Section 15.3 
for more information on editing test pro-
grams on a PC).

The 4-wire pairs are listed separately.
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25. Calibration
Each new Cirris tester is calibrated in accordance with the requirements of ANSI/NCSL Z540-1 before it leaves the 
factory and includes a certificate of calibration valid for one year. At a minimum, Cirris recommends that testers 
be returned to the factory annually for calibration or that the calibration be verified annually using a Performance 
Verification Kit available from Cirris. 

The date of the last calibration verification is displayed on the tester’s Main Menu along with the calibration 
verification due date. The default interval for calibration is one year but the due date can be changed during the 
verification process.

The Performance Verification Kit includes a manual detailing the verification process and calibrated standards, 
traceable to NIST, which when used together can verify the tester’s calibration. No adjustments are made to the tester 
during the process. If a tester fails the verification, it typically indicates a hardware problem. After a failure, contact 
Cirris Technical Support with a description of the failure condition for assistance. If the tester passes, it’s ready for 
continued use until the new calibration verification due date.

More information on the Performance Verification Kits can be found in the 4200 or 4250 Performance Verification 
Manuals. Contact your Cirris sales representative for pricing and availability.

Note:  Do not open the tester chassis or make any attempt to repair the tester hardware as this action will void 
the tester’s warranty.
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26. Optional Features

26.1  PC Control with Easy-Wire™ Software
4200 Series testers can be controlled by a PC running the Windows 10 or operating systems and the optional Easy-
Wire Software. Contact your sales representative for information on obtaining a software license.

Easy-Wire Software provides extra features and benefits such as:

● More reporting options

● Compatibility with other Cirris testers

● Expanded test methods and instructions

● And other features

See cirris.com for more information.

26.2  Scripting
The LUA programming language can be used to develop scripts that can accommodate a wide range of custom 
functions including specialized device testing and unique automation communication protocols. Scripting is available 
as an option on the 4200 Series testers. Contact your sales representative to discuss your application needs in detail 
to determine if the optional scripting capability will support your requirements.

● Reference the Cirris Easy-Wire scripting manual when the tester is controlled by Easy-Wire.

● Reference the Cirris LUA Scripting manual when scripting is run on the 4200 tester without Easy-Wire.

26.3  Data Collection
The Data Collection option enables 4200 Series testers to collect and save test results data for archive purposes 
and/or for analysis.  See Section 14 for more information.

26.4  AC Dielectric Withstand (DW) Testing
As an option, the 4250 tester can be equipped with the capability to perform Dielectric Withstand (DW) testing at up 
to 1000 VRMS using a maximum current threshold of 0.1 mA to 1.5 mA.
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27. Maintenance and Service

 27.1  Maintenance
Do not open the tester chassis. Opening the chassis will void your warranty. The 4200 Series tester contains no inter-
nal user serviceable parts. Cleaning or routine maintenance of internal parts should be done at Cirris.

Do not try to replace the lithium battery on the MCAN board. Should this battery, or any internal parts malfunction, 
contact Cirris for a repair.

Any exterior cleaning should be done using a clean, damp rag. Avoid using cleaning agents or chemicals on any part 
of the unit. 

 27.2  Firmware Updates
The firmware that controls the 4200 Series testers is regularly updated to add the latest improvements. These 
updates are posted on the Cirris web site and it’s recommended that users periodically check for new revisions and 
install the latest available version on the tester. 

Checking for Firmware Updates

To check for updates visit the Cirris web site and from the Home Page select Products > Testers > 4200 or 4250.  On 
the tester page select the Downloads tab. If the 4200 Series Firmware Updater displayed there includes a version 
newer than the one installed on the tester, download the updater. The firmware version currently installed on the 
tester can be found in one of two ways:

	● On the tester, from the Main Menu select System Settings > About.  The firmware version will be displayed as 
“Cirris OS” followed by the revision (e.g. Cirris OS v 2019.4.1.24).

	● If the tester is connected to the Cirris Hub, the firmware version installed on each tester connected to the Hub is 
displayed under the Testers page.

Downloading and Installing the Firmware Updater

The 42XX Firmware updater should be installed on a PC that can be connected to the tester using a USB cable. 

1.	 From the Main Page of the Cirris web site, select Products > Testers > 4200 or 4250. On the tester page select 
the Downloads tab. Select the link for the 4200 Series Firmware Updater and download the installation package.

2.	 Unzip the 42XX Firmware Updater to an accessible location on the PC.  Contact Cirris if the unzipping the 
updater requires a password. 

3.	 Install the 42XX Firmware Updater on the  PC by running the downloaded installation package and following 
the instructions on the screen. During the installation, Windows Defender may pause the installation and display 
the message below. If so, click on “More Info” then “Run anyway” on the subsequent window. If the installation 
pauses for an unknown reason, it’s likely this window is hidden behind another.  You may also see a pulsating 
Windows Defender shield icon in the task bar.  
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Updating the Firmware

To run the 42XX Firmware Updater:

1.	 Open the 42XX Firmware Updater. The installation does not place a 
shortcut on the desktop.  Therefore, click on the Windows Stat button and 
then expand the Cirris folder to show the list of installed Cirris software.  
Select the 42XX Firmware Updater to open the application.

2.	 Turn off the tester but make sure it’s connected to power and connect the 
tester to the PC using a USB cable. 

3.	 Follow the instructions on the 42XX Firmware Updater screen to complete the update. The default location the 
firmware directory is the location in which the installation stored the required files. It’s not necessary to change 
this directory unless you’ve been provided with beta firmware, in which case you’ll be provided with additional 
instructions. 

 27.3  Service and Repairs
If technical support is required or if your tester needs service, please contact your Cirris sales representative. In 
the United States you can also reach our Technical Support Department directly at TechSupport@Cirris.com or by 
telephone at 1-801-973-4600, extension 666.
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28. Frequently Asked Questions
How can I know what values to use in each test setting?

If settings are not specified in the cable build instructions and you are hesitant about using the default settings in the 
software, you can turn to the industry accepted wire assembly guide, A-620. More information about this guide can 
be found by visiting cirris.com. 

You can also calculate some settings using tools such as the Cirris calculators found at cirris.com.

Is high voltage testing dangerous?

The 4200 and 4250 testers are designed to limit the hazards associated with electrical testing. However, high 
voltage testing on the 4250 presents some risk and, therefore, children, women who are pregnant, and people with 
electronically controlled medical devices should not perform high voltage testing. To limit the shock hazard of high 
voltage testing the high voltage energy limit of the 4250 is 35mj and the high voltage charge limit is 45 μc. 

How do I calibrate my tester?

The act of calibrating a tester should only be performed by Cirris or a third-party calibration lab. To verify calibration 
and functionality, you can purchase a Performance Check Kit from Cirris. 

Every Cirris tester that leaves our factory is calibrated in compliance with ANSI/NCSL Z540-1-1994 and ISO-10012 to 
standards traceable to the NIST in the United States. For more information, visit cirris.com. 

The calibration of the tester should be verified annually at a minimum.

Where do I find current manuals?

The most current manuals can be found by contacting your Cirris representative or visiting cirris.com.
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29. Factory Defaults
The following table lists the settings for the 4200 Series testers and their corresponding factory defaults.

Preferences

Low Voltage Start Cable Attach

High Voltage Start Auto Start Delay

HV Auto Start Delay 0.5 S

Intermittents Test For Duration

Intermittents Test Duration 2 S

Enter Lot ID OFF

External Start Switch OFF

External Safety Switch OFF

Error Location OFF

LV Settings

Connection Resistance 10.0 ohm

LV Insulation Resistance 100 k ohm

High Voltage - 4250 only

High Voltage ON

HV Basic Settings

High Voltage 50 V

Insulation Resistance 5 M ohms

Dwell Time 2 mS
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HV Advanced Settings

DW Voltage 50 V

DW Max Current 0.1 mA

DW Dwell Time 10 mS

AC Frequency 60Hz

Cycles 1 Cycle

IR Voltage 50 V

IR Minimum Resistance 50 M ohm

IR Dwell Time 2 mS

IR Soak Time 0 S

Soak Until Good OFF

Components Settings

All OFF

Data Collection

Data Collection OFF

Measured Values OFF

Error Text OFF

System Settings

Volume 20

Date MM_DD_YY

Time 24

Mains Frequency 60 Hz
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30. Troubleshooting
Visit www.cirris.com/learning-center for articles on troubleshooting. If you need additional help, contact Cirris Techni-
cal Support at techsupport@cirris.com or 1-800-441-9910 ext 666.

A high percentage of tests fail 

Too many tests failing could be caused by several possibilities.

● Error in the Learned device: If a cable with mistakes or defects is used as the primary cable to create the test
program, then all good cables will fail because they are tested using bad test instructions.

● Fixturing: Failures can occur if the fixturing is not built and connected correctly. See the Fixturing section of
this manual for help (page 14).

● Tester Interface/Unit: A problem with the tester may occur on the tester interface (the part of the tester visible
to the user), or within the tester unit (the wiring and other pieces contained inside the chassis). Problems with
the tester interface might be repairable by the user while problems with the tester unit should be evaluated by
the tester manufacturer. If you suspect a problem with your tester unit, verify your tester is calibrated. You can
purchase a verification kit from Cirris. If necessary, you may have to send the tester to Cirris for repair.

● High Voltage – 4250 only: To troubleshoot a high voltage failure such as a dielectric failure, remove the DUT
and Learn a new test program with the same high voltage settings. The tester may display a warning indicat-
ing no connections are found. Proceed to perform the Learn and test. If the same dielectric failure occurs, the
problem is either with the test fixture or the tester interface. If possible, try testing the same device with differ-
ent fixturing. If the problem still occurs, the error is the most likely source of the problem.

● Environment: Occasionally failures can be caused by factors in the environment such as humidity and materi-
als. For example:

○ Humidity: Humidity related IR failures will usually report as an IR or HV leakage failure. High humidity can
allow moisture paths for small amounts of current to flow between unintended connections.

○ Materials: Consider the materials selected, the type of environment you operate in, and the number of
cycles the fixturing can endure. If there is any question of suitability in materials, try looking at the manufac-
turer’s specifications.

No Sound 

The tester uses sound prompts to provide feedback to the operator. If the tester is not making any sound, check 
the tester volume. 

From the Main Menu, press System Settings. 

Press the Volume button.

If the volume is set to 0, the tester will not make any sounds. Enter a number between 1-100.
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31. Glossary
Adapters: Interchangeable devices with connectors that attach the cable being tested to the tester

Connections: The continuous electrical path between 2 or more points wherein current flows. The path is 
constructed with metal parts, such as copper wire, contacts, terminations, splices, and mating contacts of connectors.

Device-Under-Test (DUT): The cable, harness, or other assembly that is being tested by the cable tester.

Dielectric Withstand (DW): The tester applies the required voltage for the determined amount of time and watches 
for current flow. Ideally, no current flows and the cable is not harmed.

Fixturing: The test interface or adapter cables  that connect the device-under-test to the tester.

Hipot/High Voltage Test: A high voltage or hipot test checks for “good isolation.” This test checks that no current 
flows between points where there should be no current.

Intermittent Errors: Errors that occur sporadically or inconsistently. 

Intermittents Test: Gives the operator a chance to move and flex the cable, searching for intermittent errors.

Insulation Resistance (IR): The test applies a voltage and measures the current to determine if the resistance of the 
insulation is high enough.

Had Leakage error: Occurs because more current than is acceptable leaks between unconnected points.

Learn: The process of the tester scanning a known-good cable to create a test program.

Low Voltage Test: The tester applies a current to the wire and measures the voltage. If the wire is connected 
correctly, the test will read low resistance, meaning current is flowing through the wire as expected and reaching the 
required connections.

Miswire: An unintended connection which is the result of a misplaced contact within a connector.

Net: Two or more interconnected points in a cable or harness. 

Open: The intended electrical path contains a gap across which electric current cannot pass.

Overcurrent error: A larger amount of the current is able to flow through the wire than the tester expects.

Short: An unintended connection between 2 or more parts. This failure indicates insufficient insulation between metal 
conductors which were not intended to be connected.

Test Program: The list of instructions used to test cables and harnesses.
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32. Specifications

Test Points
128 points; expandable to 1024 points in 128-point increments

Low Voltage Test
2 Wire

● Voltage: 4 V max

● Current: 3 μA to 6 mA

● Resistance: 0.1 Ω to 100 k Ω ± 1% ± 0.1 Ω, 100k Ω to 5 MΩ ± 10%

4 Wire

● Voltage: 4 V max

● Current: 1 mA to 1 A

● Resistance:

○ 4200:  .005 Ω to 10 Ω ± 2% ± .005 Ω

○ 4250:  .001 Ω to 10 Ω ± 2% ± .001 Ω

Component Tests

● Diodes: Silicon, LEDs, zeners with breakdown > 4V

● Resistors: 0.1 Ω to 100k Ω ± 1% ± 0.1 Ω, 100 kΩ to 5 MΩ ± 10%

● Capacitors: 5 nF to 100 μF ±10% ± 0.02 nF

● Twisted Pairs: Verify proper pairing in twisted pair cables (4250 only)

High Voltage Test – 4250 only
Insulation Resistance Test

● Voltage: 50 to 1500 VDC ± 5% ± 5 V (2000 VDC optional)

● Resistance: 5M Ω to 1000 MΩ ± 10%

Dielectric Withstand Test

● Voltage: 50 to 150 VDC ± 5% ± 5 V (2000 VDC optional, 50 to 1000 VAC optional)

● Current Limit: 0.1 mA to 1.5 mA

● Max Capacitance Per Net: 150 nF @ 300 VDC, 90 nF @ 500 VDC,
45 nF @ 1000 VDC, 30 nF @ 1500 VDC, 9.5 nF @ 1000 VAC

● HV Energy Limit: 35 mJ

● HV Charge Limit: 45 μC

Max Points per Net:  100
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Digital Input/Output
4 Inputs / 6 Outputs, 24 V Open collector, +10 V and +5 V each current limited to 100 mA

Test Point Interface
Cirris Adapter System

User Interface
● Display: 7 x 3.5" color graphical display with capacitive touch screen (800 X 480-pixel resolution).

● Localization: English, Spanish, French, and Chinese with ability to translate to other languages as needed.

● Memory: Internal memory for test program storage (8 GB or more).

● File transfer: Transfer test programs either by connecting directly to a PC or using a USB flash drive.

● Printing: Local label printing via serial ports. Network printing via Cirris Hub™ Software.

● Optional PC control: Additional advanced features via Easy-Wire™ Software.

Power
105 -135 V, 60 Hz, 210 -260 V, 50 Hz

Size
● Main Unit: 17.35" x 6.47" x 7.08" (44.07 cm x 16.43 cm x 17.98 cm)

● Add-on Box: 6.24" x 5.22" x 7.08" (15.85 cm x 13.26 cm x 17.98 cm)

Weight
● Main Unit: 11.35 lb (5.15 kg)

● Add-on Box: 5.00 lb (2.27 kg)

All Cirris products are manufactured in Salt Lake City, Utah, United States of America.
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